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About this document

This document discusses the usage of RSE for z/OS® systems. It includes brief
instructions on how to work with RSE on z/OS systems. For the generic RSE
usage, see Generic RSE User's Guide (SC27-8432).

The following names are used in this manual:
v IBM® Explorer for z/OS is called z/OS Explorer.
v Remote System Explorer is called RSE.
v z/OS UNIX System Services is called z/OS UNIX.
v IBM Developer for z Systems™ (previously known as Rational® Developer for z

Systems) is called IDz.

This document is part of a set of documents that describe the usage of z/OS
Explorer. Each of these documents has a specific target audience. You do not have
to read all of these documents to complete the z/OS Explorer usage.
v IBM Explorer for z/OS User's Guide (SC27-8431) describes in detail all of non-RSE

perspectives, views, and tasks.
v Generic RSE User's Guide (SC27-8432) describes filters, profiles, shells and

commands, and search of RSE.
v RSE for z/OS User's Guide (SC27-8433) describes usage of RSE on z/OS systems.

Who should read this book

This document is intended for developers and system programmers who are using
any of the products in the IBM Explorer for z/OS family. The IBM Explorer for
z/OS provides access to basic z/OS resources and functions. IBM Explorer for
z/OS also provides a workbench that can be used to install additional compatible
Eclipse-based products to provide a powerful platform to access z/OS subsystems
and develop and debug z/OS applications.

This document describes steps to complete different tasks for RSE in IBM Explorer
for z/OS.
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Chapter 1. Remote System Explorer overview

The Remote System Explorer (RSE) is a perspective that provides an interface for
managing remote systems with conventions that are similar to ISPF.

As you work in this perspective, you can do these tasks:
v Define and connect to remote systems
v Manage your connections
v View lists of resources
v Add or modify file mappings
v Allocate or delete data sets
v Create or delete members
v Edit text
v Submit JCL
v Submit TSO commands
v Add or modify job filters

To open the Remote System Explorer, if it is not already open when you start, do
these steps:
1. In the workbench, select Window > Open Perspective > Other.
2. Click Remote System Explorer.
3. Click OK. The Remote System Explorer opens.

The Remote System Explorer contains the following views:
v Remote Systems view
v Properties view
v Outline view
v Tasks view
v z/OS File System Mapping view
v Team view
v Remote Scratchpad view
v Remote Systems Details view
v Remote Edit History view

You can close views and open views to customize the perspective.

To close a view, click the X close button in the upper right corner of the view.

If you close a view, you can open the view again. To open one of the default views
that were closed:
1. In the workbench, select Window > Show View. A menu that lists the default

views associated with the Remote System Explorer perspective is displayed.
2. Click the name of the view you want to open.

To open a view that is not a default for the perspective you are working in, you
must determine the perspective that contributes the view:

© Copyright IBM Corp. 2017 1



1. In the workbench, select Window > Show View > Other. Folders are listed for
each perspective that is defined in the workbench.

2. Search through the folders until you find the view you want to open.
3. Click the name of the view you want to open.

When you have a custom mix of default and other views you would like to use
repeatedly based on a perspective, you can save this customized perspective:
1. In the workbench, select Window > Save Perspective As.
2. Type a name for your customized perspective in the Name field.

You can now open, close, and reset the customized perspective to the default
configuration you defined when you saved the customized perspective.
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Chapter 2. Accessing resources on local systems

With the RSE in z/OS Explorer, you can explore and search the local file system.

Exploring the local file system
The remote systems view displays locations on your local file system. You can
navigate in a local system from this view.

Before you begin

To explore the local file system in the Remote Systems view, you must define a
filter for the local system. This filter can be mapped to the root of the system or to
a specific location on the system.

Procedure
1. Select the file system that you want to explore by clicking the file system on the

tree view. The content of the selected system expands as you continue to click
the + symbols to expand.

2. Continue navigating until you find the file you are looking for.
3. Select the file. The properties information is displayed in the Properties view. If

the correct version of the file is displayed, you can open the file for editing.
Related tasks:
“Searching the local file system”
You can search your local file system for a file with a known name or pattern.

Searching the local file system
You can search your local file system for a file with a known name or pattern.

Before you begin

If you are going to work with local files in the Remote Systems view, you must
first define a filter for the local file system. This filter might be mapped to the root
of the system or to a specific location in the file system.

Procedure
1. Select the local file system that you want to search by clicking the file system in

the tree view.
2. Click + to expand Local and Local Files. The view lists filters for the local

system.
3. Expand the appropriate filter to see your local folders and files.
4. Select a folder to search and then click Search on the menu. The Search

window opens with the Folder populated. The cursor is positioned at the
Search string (leave empty for file search) field.

5. If you want to specify a name pattern to search, enter the name pattern in the
File name patterns field and select Search. If the search is successful, the
results are displayed.

6. Look through the list of results and select the file that you want to see.
7. Click Open. The file opens in the editor.
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Related tasks:
“Exploring the local file system” on page 3
The remote systems view displays locations on your local file system. You can
navigate in a local system from this view.
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Chapter 3. Accessing resources on remote systems

With the RSE in z/OS Explorer, you can access and work with resources on remote
systems.

You can do these tasks that are described in this chapter on a z/OS remote system.

Creating a connection to a z/OS system
Before you can connect to a remote system from the IBM Explorer for z/OS client,
you must define a connection for it and specify connection properties.

About this task

Restriction: Define only one connection to a particular remote system in each
workspace. If you define multiple connections to a single remote system, and your
site uses the push-to-client function to distribute updates to remote system
connections, then all connections to the remote system are updated. The IBM
Explorer for z/OS product does not support different configurations of the same
remote system in a single workspace.

Procedure
1. In the Remote Systems view, expand New Connection and double-click z/OS.
2. In the New Connection window, select a profile name from the list.

Tip: If you are creating a connection for the first time, you are prompted to
create a profile before you can create the new connection. After you create the
connection, you can share this profile to allow other users to have this
connection in their Remote Systems view.

3. Enter the following values in the fields on this window.

Host name
The TCP/IP address of the remote system.

Connection name
The short name to call the system. For example, MYSYSTEM.

Description
A description of the connection.

Verify host name
Select this check box to verify that the host name is valid before you
connect.

4. To define the connection with default values for the MVS Files, z/OS UNIX
Files, and z/OS UNIX Shells subsystems, click Finish. To set properties for
these subsystems, click Next. The wizard opens a properties window for each
subsystem. These pages display the properties of the underlying services that
are used by each subsystem. For more information about the properties you
can set for a subsystem, see the related topics.

Results

The Remote Systems view displays the short name of the new connection with five
nodes under the connection name:
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v z/OS UNIX Files is the z/OS UNIX file subsystem. This node contains two
folders: My home and Root. You can create more z/OS UNIX file folders by
adding new filters to this node.

v z/OS UNIX Shells is a command subsystem. When you open a z/OS UNIX
command shell, its name is displayed under this node.

v MVS Files is the MVS™ file subsystem. This node contains three folders: My Data
Sets displays MVS files that match the filter userid.* in which userid is the user
ID with which you connected to the remote system. You can create more MVS
file folders by adding filters to this node. You can change the sort order of data
sets by using the MVS Files preference page. Retrieved Data Sets displays data
set names searched for and added by using the Retrieve Data Sets action or by
allocating a data set. My Search Queries displays search queries that you ran
and saved in the Remote z/OS Search view.

v TSO Commands is a command subsystem. When you open a TSO command
shell, its name is displayed under this node.

v JES is the JES subsystem. This node contains two folders: My Jobs displays jobs
that are submitted under the user ID with which you connected to the remote
system. You can create more job folders by adding new filters to this node.
Retrieved Jobs displays jobs searched for and added by using the Retrieve Job
action.

What to do next

Connect to the remote system. After you connect to the remote system, you can
control the contents that are displayed under JES, MVS Files, and z/OS UNIX
Files by defining filters for these subsystems. You can add search queries to the
MVS Files folder by running and saving remote z/OS searches. For instructions,
see the related topics.

Connection properties for remote subsystems
On each properties page of the New Connection wizard, you can select the
configuration to be used for the subsystem and edit the properties for each
available service in that configuration. You can select from the following server
launchers. If you are not sure which option to choose, contact your systems
administrator.
v Remote daemon: Establishes a connection by using the remote daemon to start

the server. To use this option, the remote daemon must be running on the
remote system. If you choose this option, specify the following extra options:
– Daemon Port: Specify a valid port number.
– Authentication method: Choose a method for authenticating with the remote

system. Select userid/password if you log on to the remote system by using a
user ID and password. Select certificate if you use client certificate
authentication. Client certificate authentication is for users who must connect
to a remote system by using a device such as an integrated circuit card (like
smart card). For more information, see “Creating a connection for client
certificate authentication” on page 7.

If you choose this option, you must start the server daemon by using a user ID
with appropriate privileges.

v Connect to running server: Establishes a connection with a server that is already
running on some known port. To use this option, the server must be started
before you attempt to define a connection in the Remote System Explorer. The
port must be specified on the Subsystem properties page before you can connect
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to the server. If you choose this option, you also must specify the Use SSL/TLS
for network communications option, which connects by using SSL or TLS.

Related tasks:
“Creating a connection to a z/OS system” on page 5
Before you can connect to a remote system from the IBM Explorer for z/OS client,
you must define a connection for it and specify connection properties.
Related information:

Defining extra Java startup parameters with _RSE_JAVAOPTS

Creating a connection for client certificate authentication
The IBM Explorer for z/OS remote systems environment supports client certificate
authentication for users who must connect to a remote system with a device such
as an integrated circuit card (like smart card).

Before you begin

Your security device must be connected to your workstation and logged on to your
local system according to your site requirements.

Procedure

To create a connection to a remote system for client certificate authentication, do
these steps:
1. Set preferences for client certificate authentication.
2. Create a connection to the remote system.
3. Select certificate from the Authentication method list.
Related tasks:
“Creating a connection to a z/OS system” on page 5
Before you can connect to a remote system from the IBM Explorer for z/OS client,
you must define a connection for it and specify connection properties.

Connecting to a remote system
Follow these steps to connect to a remote system.

Before you begin

Create a connection to a remote system.

Procedure
1. In the Remote Systems view, select a z/OS connection.
2. Right-click and select Connect. The Enter Password window opens.
3. On the Enter Password window, type your user ID and password.
4. Optional: To save your user ID and password, select the Save user ID and

Save password check boxes.

Note: The Save password check box can be disabled. For more information,
see the #_RSE_JAVAOPTS="$_RSE_JAVAOPTS -DDENY_PASSWORD_SAVE in the related
topics.

5. Click OK. If the remote system is configured to secure the connection with
encrypted communication, the Import Host Certificate window opens. This
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window opens the first time that you attempt to connect to a remote system
secured with encrypted communication. Subsequent connections use the
imported host certificate. When a remote system connection is secured, the
Properties view for the MVS Files subsystem displays SSL Enabled.

6. Optional: Click Finish to import the host certificate.
7. Optional: If the remote system is configured for push-to-client, you might be

prompted to accept configuration updates. For more information about
updating configurations and preferences, see the related links.

What to do next

System administrators can configure remote systems to automatically disconnect
users after a period of inactivity. Contact your system administrator if you have
any questions about maintaining an active connection to a remote system.
Related information:

Defining extra Java startup parameters with _RSE_JAVAOPTS

Updating workspace configurations and preferences

Connecting to a remote system through the Interactive ISPF
Gateway

Use this procedure to connect to a remote z/OS system when the Interactive ISPF
Gateway is enabled on the server.

Before you begin

The product client and server must be version 9.5 or later, and the Interactive ISPF
Gateway must be enabled on the server. For more information about enabling the
Interactive ISPF Gateway on the server, see these topics:
v rse.env, the RSE configuration file
v (Optional) Interactive ISPF Gateway

About this task

To minimize problems connecting to the remote system through the Interactive
ISPF Gateway, observe these practices:
v When you log on to TSO through the Interactive ISPF Gateway, do not specify a

procedure that starts ISPF panel applications.
v As with regular TSO logon through a 3270 session, TSO stores the logon data in

your security TSO segment, replacing what was already there. This situation can
result in unexpected logon values if you uses different values to log on to a TSO
session through 3270.

v If you use multiple Interactive ISPF Gateways simultaneously, or if you log on
to TSO through 3270 and through the Interactive ISPF Gateway simultaneously,
TSO and ISPF must be set up to allow multiple simultaneous logons.

Procedure
1. In the Remote Systems view, select a z/OS connection to a server that has the

Interactive ISPF Gateway enabled.
2. Right-click and select Connect. The Enter Password window opens.
3. On the Enter Password window, type your user ID and password.
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4. Optional: To save your user ID and password, select the Save user ID and
Save password check boxes.

Note: The Save password check box can be disabled. For more information,
see the #_RSE_JAVAOPTS="$_RSE_JAVAOPTS -DDENY_PASSWORD_SAVE in the related
topics.

5. Click OK. If the remote system is configured to secure the connection with
encrypted communication, the Import Host Certificate window opens. This
window opens the first time that you attempt to connect to a remote system
secured with encrypted communication. Subsequent connections use the
imported host certificate. When a remote system connection is secured, the
Properties view for the MVS Files subsystem displays SSL Enabled.

6. Optional: Click Finish to import the host certificate. The TSO Logon window
opens. The fields on this window are populated with default values. For more
information about the values you need to specify, see your systems
administrator. These values, or any new values that you enter, are saved on the
TSO Logon page of the Properties for TSO Commands window.

Important: The procedure name you specify in the Procedure field cannot start
an ISPF panel. If the procedure starts an ISPF panel, the logon request fails.

7. Click OK. The connection is completed.
8. Optional: If the remote system is configured for push-to-client, you might be

prompted to accept configuration updates. For more information about
updating configurations and preferences, see the related links.

Related tasks:

Updating workspace configurations and preferences
Related information:

Defining extra Java startup parameters with _RSE_JAVAOPTS

Enabling automatic login for RSE connections
The connections that you define in the Remote System Explorer can be
automatically connected when you start the product.

About this task

This task explains how to set preferences for the automatic login for RSE
connections.

Procedure
1. From the menu bar, click Window > Preferences.
2. On the Preferences page, click Remote Systems.
3. On the Remote Systems page, select Automatically connect on startup.

Results

The RSE connections are automatically connected when you start the product.

Setting preference for clearing cached files
Use the File Cache preference page to set options for clearing cached files.
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Procedure
1. From the main menu, select Window > Preferences.
2. In the Preferences window, expand Remote Systems > File Cache.
3. On the File Cache preference page, you can set these options:
v Clear cached files on shutdown: Use this option to automate cached file

clearing. When you select this option, the remote files that are cached will be
deleted whenever you close the workbench.

v Limit cache size: Use this option to set the maximum cache size of the
cached files.

v Clear Cached Files: Use this option to manually clear cached files.
4. To save the settings, click OK.

Changing your password
You can change your password on a remote z/OS system to which you are
connected.

Before you begin

You must be connected to the remote system on which you want to change your
password.

Procedure
1. From the Remote Systems view, right-click the connection name.
2. From the menu, select Change Password. The remote system daemon must be

at version 3.0 or later, and you must be connected to the remote system for this
menu item to be enabled. The Change Password window opens. This window
displays the following information:
v Host name: The name of the remote system.
v User ID: The user ID for which you are changing your password.
v Current password expires on: The date on which your current password

expires.
v Cycle in days: The number of days before your new password expires.

3. In the New password field, type your new password.
4. In the Re-enter to confirm field, type your password again.
5. Click OK to change your password.

Disconnecting from a remote system
Follow these steps to disconnect from a remote system.

Procedure
1. Open the Remote Systems view.
2. Expand the Remote Systems list and select a system.
3. Right-click and select Disconnect.
4. Click Yes to confirm.
Related information:
Chapter 1, “Remote System Explorer overview,” on page 1
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Deleting a remote system
Follow these steps to delete a remote system from the list.

Procedure
1. Open the Remote Systems view.
2. Expand the Remote Systems list and select a system.
3. Disconnect from the remote system.

Note: You must be disconnected from a remote system before you can delete it.
4. Right-click and select Delete.
5. Click Yes to confirm. The system is deleted from the list.
Related information:
Chapter 1, “Remote System Explorer overview,” on page 1

Finding remote z/OS resources
IBM Explorer for z/OS provides several tools for searching and locating remote
z/OS resources.1

Table 1. Remote resource search tools

If you know If you want to know Use this tool
Link to more
information

The content of a data
set or member, or a
partial name

Where that content
occurs or the full
name

Remote z/OS Search “Searching a remote
z/OS system”

A full or partial data
set name

How to find it Retrieve Data Set “Retrieving data
sets” on page 36

A full or partial
partitioned data set
member name

How to find it Find Member “Finding members”
on page 38

The data set filter
and a full or partial
data set name

How to find it in a
large filter

Locate Data Set “Working with large
filters” on page 35

The name of a
partitioned data set
(PDS) and part of the
member name

How to find it in a
large PDS

Locate Member “Working with large
partitioned data sets”
on page 41

A job name How to find it Retrieve Job “Retrieving jobs” on
page 72

Searching a remote z/OS system
You can search a z/OS system for file names or for files that contain a search
string.

1. For IDz users, if you know the content of a data set or member and a full or partial file name, you can also use Remote z/OS File
Search. For more information, search for Searching remote z/OS files in IDz KC.
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Before you begin

Connect to a remote system.

The search function can return search results incrementally so that you can begin
working with search results before all results are returned. This function is
controlled by a setting in the Remote z/OS Search preference page. To open this
page, click Preferences at the bottom of the Remote z/OS Search window. For
more information about controlling how frequently search results are updated, see
Setting preferences for Remote z/OS Search.

About this task

The Remote z/OS Search window provides various options for searching z/OS
systems. The following procedure provides basic search instructions. For more
information about the various search options, see “Setting other search options” on
page 16.

Tip: The Remote z/OS Search window retains the following search options that
are used for a previous search, if you do not select a different object for the search:
v The options in the Search for area
v The With name field
v The Content strings field

If you select a new object for a search, the search function prepares a new search
and clears these options.

The following search options are always retained:
v The Regular expression check boxes in the Search for area
v Settings in the Search result options area
v Settings in the Content string options area
v The setting of the Search Options push button (expanded or collapsed)

Procedure

To search for a file or for file content on a z/OS system:
1. To open the Remote z/OS Search window:2

v Click Search on the toolbar.
v Press Ctrl+H.
v Select Search > Search from the menu bar.
v In the Remote Systems view, right-click the file or container to search, and

then select Search from the menu.
2. Click the Remote z/OS Search tab. Remote z/OS Search is the default search

view when you initiate a search from these views or editors:3

v Remote Systems view
v Remote System Details view

2. For IDz users, you can also open the Remote z/OS Search window in one of the following ways:

v In the z/OS Projects view, right-click the file or container to search, and then select Search from the menu.

v In the COBOL Editor, PL/I Editor, or z Systems LPEX Editor, highlight a string and press Ctrl+H.

3. For IDz users, you can also initiate a search from z/OS Projects view, COBOL Editor, PL/I Editor and z Systems LPEX Editor.
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v JCL Editor
3. Choose the type of file you are searching for:
v Data set member: Select this option to search for a data set member.
v Sequential data set: Select this option to search for a sequential data set,

VSAM data set, or generation data set.
v Partitioned data set: Select this option to search for a partitioned data set or

generation data group.
4. Optional: In the With name field, type the file name to search for. This field is

optional when you are searching for file contents rather than a file name. If the
Regular expression check box is not selected, you can use wildcard characters
in the With name field. Valid characters include * to match any string and ? to
match a single character. Wildcard characters are not allowed in a high-level
qualifier.

Important: To use the ? wildcard character, both the client and server must be
version 3.0 or later. For examples of using the ? wildcard character, see
“Including the ? character in a content string search” on page 14

5. Optional: In the Content strings field, type the text to search for. To search for
a file name, leave this field blank (or type * in the field). To search within a file,
you must specify a content string in this field. You can use wildcard and escape
characters in the Content strings field. Valid characters include * to match any
string, ? to match any character, and \ to specify an escape character for these
literals: * ? or \. For an example of constructing an AND search query, see
“Constructing an AND search query” on page 14.

Note: The Content strings field is not available for Partitioned data set
searches.

6. Optional: Select the Regular expression check box to enter a regular expression
for the With name or Content strings field. You can use the \xhh escape
sequence in the Content strings field to search for hexadecimal content in a
remote z/OS file. For more information about searching for hexadecimal
content, see the related topics. For the meaning of * and ? in regular
expressions, see Class Pattern. For examples of constructing a regular
expression search, see “Constructing a regular expression search” on page 15.

7. Click Search.

Results

The search window closes and the Remote z/OS Search view opens, listing the
search results. A search can return two types of results:
v If you type a string in the With name field and leave the Content strings field

empty, then the search returns a list of data set or member names as the search
result.

v If you type a string in the Content strings field, then the search returns a list of
content strings as the search result.

You can double-click files that are listed in this view to open them in the editor. If
you request a search for content strings within files, you can expand the files that
are listed in this view by clicking + next to their names. The lines that match the
specified search string are listed beneath these files. You can double-click a line
number to open the corresponding file and position the cursor at that line. For
more information about working with search results, see “Working with search
results” on page 17.
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Constructing an AND search query
Example

You can use the Remote z/OS Search window to run an AND search query:
1. Open the Remote z/OS Search window.
2. In the Content strings field, type a search string with the following syntax:

.*<literal1>.+<literal2>

To find all lines in a program that contain the strings IF and WS-PHARM, for
example, type the following search string:
.*IF.+WS-PHARM

Including the ? character in a content string search
Example

You can include the ? wildcard character in the Content string field of the search
window. This character returns different results with the Regular expression
option on (selected) or off (cleared).

Table 2. Results of ? wildcard characters in content string searches.

Field name

Regular
expression
option

Use to search
for

Sample search
string

Matching
results

Content string On Search for a
character that
occurs once or
not at all in the
position
preceding the ?
wildcard
character.

VARA?B The search in a
COBOL program
that contains the
following
variable
declarations:

VARAA

VARAAB

VARAB

VARBA

VARAC

ABCVARABA

Returns matches
for the variables
VARAB, VARBA,
ABCVARABA,
because each of
these strings
contains VAR +
A[0 or 1 time] +
B.
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Table 2. Results of ? wildcard characters in content string searches (continued).

Field name

Regular
expression
option

Use to search
for

Sample search
string

Matching
results

Content string Off Search for any
single character
in the position of
the ? wildcard
character.

VARA?B The search in a
COBOL program
that contains the
following
variable
declarations:

VARAA

VARAAB

VARAB

VARBA

VARAC

ABCVARABA

Returns a match
only for the
variable
VARAAB,
because the
search string
matches only
VAR + A + [any
single character]
+ B.

Constructing a regular expression search
Example

You can perform a regular expression search using either the With name field or
the Content string field. Regular expression searches in these fields function
differently.

With name
A regular expression search in the With name field calls the regular
expression engine searching for exact matches. The search scope for this
type of search is member names (that is, you cannot use it to search data
set names). The following two examples illustrate how a regular expression
search functions with this list of member names:

COBOLTST

CBLTST

ACOBTST

1. The search pattern COB returns no results because no member name is
exactly COB.

2. The search pattern *COB* returns all member names except CBLTST.

Content string
A regular expression search in the Content string field calls the regular
expression engine searching for any match of the search string in the
content of members. Given the same list of member names, the following
regular expression searches in the Content string field return these results:
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1. The search pattern COB returns all member names except CBLTST
because the search engine is looking for any instance of COB.

2. The search pattern *COB* also returns all member names except CBLTST.
Related tasks:
“Setting other search options”
More search options are available in the Remote z/OS Search window.
“Searching for hexadecimal values in remote z/OS files” on page 17
You can use the Remote z/OS Search window to search for hexadecimal content in
remote z/OS files.
“Working with search results” on page 17
After you complete a remote z/OS search, the results are reported in the Remote
z/OS Search view. Use this view to sort or filter the search results, edit or browse
returned files, refine the search results, or add returned files to a project or
subproject. 4

“Exporting search results” on page 20
You can export z/OS search results to a text file, which you can then import into a
spreadsheet program.
“Saving search queries” on page 22
You can save a Remote z/OS Search query and run it from the Remote Systems
view.

Setting preferences for Remote z/OS Search

Setting other search options
More search options are available in the Remote z/OS Search window.

Procedure
v Set Search in options to define the scope of a search. You can set the following

search scope options:
– System to choose a remote system to search. This list shows all defined

remote system connections. If you select a remote system to which you are
not currently connected, you are prompted to log in to that system.

– Existing filters shows all defined filters for the selected remote system. If you
are searching for data set members, this list also shows partitioned data sets.

– Other contexts to specify a filter string to search. This option allows for
searching outside of defined filters.

Note: If you search on one or more remote resources outside the Remote
Systems view, this option is enabled, and it specifies <selected resources> as
the filter string.

v Set Search result options. Click Search Options to show the search result
options on the window. You can set the following search result options:
– Search results limit to set the maximum number of search results to return.

The default setting is 1000. If you search for data sets or data set members,
this option limits the number of files that are returned. If you search for
content strings, this option limits the number of strings that are returned.

– Include migrated to search and return migrated data sets.
– Include offline volumes to search and return MVS volumes that are offline.

4. For IDz users, search for Working with search results in IDz KC.
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v Set Content string options. For data set member and sequential data set
searches, click Search Options to show the content string option on the window.
The option is not displayed for partitioned data set searches. You can set the
following content string option:
– Case sensitive finds only strings that match the case in which you enter the

search string.
Related tasks:
“Searching a remote z/OS system” on page 11
You can search a z/OS system for file names or for files that contain a search
string.

Searching for hexadecimal values in remote z/OS files
You can use the Remote z/OS Search window to search for hexadecimal content in
remote z/OS files.

Procedure
1. In the Content strings field of the Remote z/OS Search window, type the

hexadecimal escape sequence \xhh. The following examples show hexadecimal
escape sequences:
v \x09 (tabulator)
v \x4A or \x4a (character J)

The code page that is used for hexadecimal escape sequences is the default host
code page that is specified in the Code Page page of the Properties for MVS
Files window. To open this window, select the MVS Files subsystem and click
Properties.

2. Select the Regular expression check box next to the Content strings field.
3. Complete the remaining fields as described in “Searching a remote z/OS

system” on page 11.

Working with search results
After you complete a remote z/OS search, the results are reported in the Remote
z/OS Search view. Use this view to sort or filter the search results, edit or browse
returned files, refine the search results, or add returned files to a project or
subproject. 5

Before you begin

You can set several search options and preferences to control the content and
function of this view. For more information about these options and preferences,
see the related links.
v To limit the number of search results that are returned in this view, use the

Search results limit field of the Remote z/OS Search window. The default
setting is 1000. If you search for data sets or data set members, this option limits
the number of files returned. If you search for content strings, this option limits
the number of strings returned.

v To control how often the search results are updated, use the Result update
frequency control of the Remote z/OS Search preferences page. The search
function returns search results incrementally so that you can begin working with
search results before all results are returned.

5. For IDz users, search for Working with search results in IDz KC.
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v To enable a preview of the files that contain a returned content string, use the
Search result preview fields of the Remote z/OS Search preferences page. These
options control the response time for content previews and the number of lines
of content to preview.

To open the Remote z/OS Search preferences page from the Remote z/OS Search
view, select Preferences from the menu on the Remote z/OS Search view.

About this task

The Remote z/OS Search view opens automatically after a search request is issued.
This view reports the results of searches in z/OS systems view. 6A remote z/OS
search can return two types of results:

Files If you enter a search string in the With name field of the Remote z/OS
Search window, the search results contain a list of sequential data sets,
partitioned data sets, or partitioned data set members.

Content strings
If you enter a search string in the Content strings field of the Remote
z/OS Search window, the search results contain a list of content strings.
The results are listed under the data set or partitioned data set member
that contains the strings.

How you work with search results differs according to the type of results returned.

Files
Procedure
v To sort the search results, click the heading of the column you want to sort the

results by. This action toggles the sort order between ascending and descending
order.

v To expand or collapse all search results, click the expand 
 

or collapse 
button.

v To add or remove columns from the view, click the edit button .
v To change the size of a column, select a column divider and move it to the left

or right.
v To filter the search results, type a string in the Filter data set or Filter member

field. This field filters the search results as you type. When the view shows the
results of a file search, the filter string is compared to the value in the Name
column for top-level results. Results that do not match the filter are removed
from the view. The filter text is not applied to the second-level items, such as
data set members of partitioned data set search results.
Filter string comparisons are not case-sensitive. If you use * in a filter string, it
matches any string. Wildcard characters are not allowed in the high-level
qualifier. If your original search request returns all sequential data sets that
match MYUSERID.*, for example, you can type MYUSERID.COBOL.* in this field to
show only the search results that match this filter.

v To view the member or data set that contains a result string in read-only mode,
select the Browse action from the pop-up menu. To edit a member or data set,
select Open.

6. For IDz users, this view also reports the results of searches in z/OS projects and MVS subprojects view.
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Note: The Browse and Open actions appear only if you select a partitioned data
set member or sequential file. They do not appear if you select a partitioned
data set.

v To show the results of previous searches, click the drop-down menu and select a
search result set from the list.

Content strings
Procedure
v Expand the data set or data set member names to see the returned content

strings.
v To preview the file that contains the returned string, hover the mouse pointer

over the string. Several lines that precede and follow the returned string open in
a window. Use the Remote z/OS Search preferences page to control the size and
timing of the preview window.

v To sort the search results, click the heading of the column you want to sort the
results by. This action toggles the sort order between ascending and descending
order.

v To expand or collapse all search results, click the expand 
 

or collapse 
button.

v To add or remove columns from the view, click the edit button .
v To change the size of a column, select a column divider and move it to the left

or right.
v To filter the search results, type a string in the Filter text field. This field filters

the search results as you type. When the view shows the results of a content
string search, the filter string is compared to the value in the Name column for
top-level and second-level items. Results that do not match the filter are
removed from the view. If the filter removes all second-level items, the parent
top-level item is also removed. If any second-level item matches, the parent
top-level item is retained. Filter string comparisons are not case-sensitive. If you
use * in a filter string, it matches any string. If your original search request
returns all file content that matches T*, for example, you can type TEST* in this
field to show only the search results that match this filter.

v To view the member or data set that contains a result string in read-only mode,
select the Browse action from the pop-up menu. To edit a member or data set,
select Open.

Note: The Browse and Open actions appear only if you select a partitioned data
set member or sequential file. They do not appear if you select a partitioned
data set.

v To show the results of previous searches, click the drop-down menu and select a
search result set from the list.

Related tasks:
“Searching a remote z/OS system” on page 11
You can search a z/OS system for file names or for files that contain a search
string.
“Exporting search results” on page 20
You can export z/OS search results to a text file, which you can then import into a
spreadsheet program.
“Saving search queries” on page 22
You can save a Remote z/OS Search query and run it from the Remote Systems
view.
Related information:
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Setting preferences for Remote z/OS Search

Exporting search results
You can export z/OS search results to a text file, which you can then import into a
spreadsheet program.

Before you begin

You must be connected to a remote system and complete a Remote z/OS Search
operation that populates the Remote z/OS Search results view.

About this task

The export operation exports the contents of the Remote z/OS Search view. If you
click the export icon before the search results view is fully populated, then not all
search results are included in the export file. To ensure that you export all search
results, wait until the view is fully populated before you click the export icon.

Restriction: The search result export wizard places some restrictions on the
content you can export. If the Remote z/OS Search view contains a list of
partitioned data sets and data set members, then you can export only the file
information about the partitioned data sets. You cannot export file information
about the data set members. If you select data set members in the Remote z/OS
Search view and click the export icon, a warning message is displayed.

Exporting all results
Procedure
1. In the Remote z/OS Search results view, click 

 
Export to file. The Export

Search Results window opens. The All results option is selected by default.
2. In the Location field, type a path name for the export file or click Browse to

select a location. You can save the export file to a local or remote location. The
output file is a text-format file. You can use any file name extension, such as
.txt or .csv.

3. Optional: Choose data selection and formatting options. If you accept the
defaults for data selection and formatting, the wizard generates an export file
with the following data and format:
v File information and content strings: If the search results do not include

content strings, then only file information is exported.
v Header and data: The export file contains one line that lists the field labels

and one line of data for each result.
v File encoding: UTF-16LE.
v Delimiter: Tab.
v Surround fields with quotes ("): Surrounds each output field with quotation

marks.

For more information about selecting other data and formatting options, see
“Formatting an export file” on page 21.

4. To export the search results, click Finish.

Exporting selected results
Procedure
1. In the Remote z/OS Search results view, select one or more rows. For search

results that contain content strings, you can select file results or content string
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results, or both. For search results that contain partitioned data sets and data
set members, you can export file information for the partitioned data sets only.
If you select data set members, a warning message is displayed.

2. Click 
 

Export to file. The Export Search Results window opens.
3. Click Selected results only.
4. Optional: Choose data selection and formatting options. If you accept the

defaults for data selection and formatting, the wizard generates an export file
with the following data and format:
v File information and content strings: If the search results do not include

content strings, then only file information is exported.
v Header and data: The export file contains one line that lists the field labels

and one line of data for each result.
v File encoding: UTF-16LE.
v Delimiter: Tab.
v Surround fields with quotes ("): Surrounds each output field with quotation

marks.

For more information about selecting other data and formatting options, see
“Formatting an export file.”

5. To export the search results, click Finish.

Formatting an export file
Procedure

To change the default data selection and format options for a search result export
file:
1. Choose the search result data to export:
v File information only exports only information about data sets or data set

members in the search results.
v File information and content strings exports information about data sets

and data members and the content strings in the search results. This option
is available only if the search results contain content strings.

2. Choose how to format the exported search results:
v Key and value: Each line in the export file contains a key and a value for

each data field. Specify a separator in the Separator field. If you choose this
format and specify a colon as the separator, then the data fields are saved in
the format key:value.
File name:HLQ.SOURCE.COBOL/MYFILE.cbl Extension:cbl Lock owner:userid
File name:HLQ.SOURCE.PLI/YOURFILE.pli Extension:pli Lock owner:userid2
File name:HLQ.SOURCE.COBOL/FILE3.cbl Extension:cbl Lock owner:null

Tip: The label for the key is specified on the next page of the wizard. You
can use the default labels or create your own labels.

v Header and data: The export file contains one line that lists the field labels
and one line of data for each result. If you choose this format and select the
Surround fields with quotes option, the export file is formatted like this
example:
"File name" "Extension" "Lock owner"
"HLQ.SOURCE.COBOL/MYFILE.cbl" "cbl" "userid1"
"HLQ.SOURCE.PLI/YOURFILE.pli" "pli" "userid2"
"HLQ.SOURCE.COBOL/FILE3.cbl" "cbl" ""
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v Data only: The export file contains only data values and no field labels. If
you choose this format and select the Surround fields with quotes option,
the export file is formatted like this example:
"HLQ.SOURCE.COBOL/MYFILE.cbl" "cbl" "userid1"
"HLQ.SOURCE.PLI/YOURFILE.pli" "pli" "userid2"
"HLQ.SOURCE.COBOL/FILE3.cbl" "cbl" ""

3. Choose how to format the export file:
v File encoding: Select UTF-16LE or UTF-8.
v Delimiter: Select a character to use as a delimiter between fields in the

export file: caret, colon, comma, semicolon, space, or tab.
v Surround fields with quotes ("): Select this option to surround each output

field with quotation marks. This option is not available if you choose the
Key and value data format option.

4. To choose the data fields to include in the export file or to change the field
labels, click Next.
a. On the Select Fields to Export page, select the fields to include in the export

file, or clear fields to exclude them. The Line number and Line text fields
are available only when the search results include content strings.

b. To change the field labels that are used for the Key and value and Header
and data file format options, type a label in the Label field. If you choose
the Data only file format, then the Label fields are disabled.

Results

The following example illustrates an export file that contains file information with
default data selection and export file format options. The first row is the header
row and the remaining three rows contain search result data.
"File name" "Extension" "Lock owner"
"HLQ.SOURCE.COBOL/MYFILE.cbl" "cbl" "userid1"
"HLQ.SOURCE.PLI/YOURFILE.pli" "pli" "userid2"
"HLQ.SOURCE.COBOL/FILE3.cbl" "cbl" ""

The following example illustrates an export file that contains content strings with
default data selection and export file format options. The first row is the header
row and the remaining three rows contain search result data.
"Name" "Extension" "Transfer" "Line" "Text"
"USER33.ZUNIT.PLI/PLITC001.pli" "pli" "text" "7" "| Component: IBM z/OS Automated Unit Testing Framework (zUnit) |"
"USER33.ZUNIT.PLI/PLITC001.pli" "pli" "text" "9" "| File: Enterprise PL/I zUnit Test Case |"

Saving search queries
You can save a Remote z/OS Search query and run it from the Remote Systems
view.

Before you begin

Before you can save a search query, you must first run a remote z/OS search and
have the search results displayed in the Remote z/OS Search view. The search
results must be limited to a single z/OS system. See the related topics for
instructions.

Procedure

To save a remote z/OS search query:
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1. In the Remote z/OS Search view, display the results of the search query you
want to save. If you completed more than one search, use the search history list
to select the search query you want to save.

2. Click the 
 

icon to save the search query. This icon is enabled only if the
search scope is limited to a single z/OS system under the following conditions:
v You search for files.
v The search scope is for a single z/OS system. The scope can be an entire

z/OS system or multiple partitioned data sets on the same system.

. The Add Query to Remote Systems View window opens.
3. Type a name for the query and click OK. The search query is added to the My

Favorites folder of the MVS Files subsystem.

What to do next

After you save a search query, you can do the following actions:
v To run a saved query, select it in the Remote Systems view and click Run Query

from the menu.
v To edit and run a saved query, select it in the Remote Systems view and click

Edit and Run from the menu. This action opens the Remote z/OS Search view,
which you can use to change the search criteria, submit the search request, and
save changes. To change the content strings of the search, edit the Content
strings field. To save changes, select Save Favorite.

Related tasks:
“Searching a remote z/OS system” on page 11
You can search a z/OS system for file names or for files that contain a search
string.
“Working with search results” on page 17
After you complete a remote z/OS search, the results are reported in the Remote
z/OS Search view. Use this view to sort or filter the search results, edit or browse
returned files, refine the search results, or add returned files to a project or
subproject. 7

Monitoring remote system resources
Use the Monitor action to view the contents and properties of remote objects and
configure polling options to refresh remote objects every 5 - 200 seconds.

About this task

You can open the Remote Monitor on a remote system, subsystem, filter, or
individual object (such as a data set, data set member, or JES job) to view details
and status of the object. You can use this view, for example, to monitor the status
of submitted jobs.

Procedure
v To open the Remote Monitor, select an object in the Remote Systems view and

click Monitor on the menu.
v To configure polling options for an object, do these steps:

1. Open the Remote Monitor on an object, such as My Jobs.

7. For IDz users, search for Working with search results in IDz KC.
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2. Click the arrow beside Poll Configuration.
3. Select the Poll check box and then move the Wait Interval slider bar to set

the refresh interval for the Remote Monitor view. You can set a value of 5 -
200 seconds. The monitor updates the status of the object at the interval you
set.

4. To stop polling the object, clear the Poll check box.

What to do next

Monitoring and polling options are not saved from one session to another. After
you disconnect from the remote system, the contents of the Remote Monitor and
any polling options you set are cleared.

The Remote Edit History view
The Remote Edit History view tracks the remote resources that you open for
editing. It helps you remember the MVS data set members and sequential data sets
that you edit, and those files you edit on z/OS UNIX and z/OS projects.

The Remote Edit History view shows up in the lower left pane of the Remote
System Explorer (RSE) perspective by default. If you need to open this view, select
Window > Show View > Other... > Remote Systems > Remote Edit History.

You can see a table of the resources that you recently opened in the view. Entries
for resources on disconnected systems will show up in gray. To edit a resource,
double-click the resource that you want to edit. Then, RSE is automatically
connected and the resource is opened.

After RSE is connected, you can right-click the selected resource and select Show
In to locate the underlying resource in a view, such as the Remote Systems view,
or the Remote System Details view, or the Remote Monitor view.

Clearing history items

You can clear history items that you are not interested in from the Remote Edit
History view. To clear the selected items, click the Remove the selected items from
history button. To clear all items, click the Remove all items from the history
button.

Setting the number of history entries

You can also set the number of history entries to keep by using the Edit History
Limit view action. The default is 30.

Comparing history items with local history

To compare a history item with its local history, right-click the selected item and
select Compare With > Local History.

Replacing history items with local history

To replace a history item with its local history, right-click the selected item and
select Replace With > Local History.
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Deleting a resource
You can delete a file in the Remote Systems view.

About this task

Deleting a resource deletes it from the remote system. 8

Note: System administrators can disable the Delete action on the Remote Systems
view. For instructions on disabling this action, refer to the IBM Explorer for z/OS
Host Configuration Guide (SC27-8437).

Procedure

To delete a resource9:
1. In the Remote Systems view or the z/OS Projects view, right-click the resource

that you want to delete and click Delete.

2. When you are prompted to confirm the deletion, click Delete. The resource is
deleted. When you delete a generation data group, all generation data sets in
the GDG are deleted and then the GDG base is deleted.

Sorting filters
In the Remote Systems view, you can create filters to group resources, such as
z/OS UNIX System Services files, MVS files, and JES jobs. Filters provide one way
to quickly locate the resources you need. Filters can be grouped into pools.

You can use the Sort action to put groups of filters into alphabetical order in the
Remote Systems view.

Before you begin

The filters must be in the same filter pool. To display filter pools in the Remote
Systems view, select the drop-down menu and then select Show Filter Pools. The
filter pools are displayed in the view.

Tip: You do not have to display filter pools to sort filters. You can use the Sort
action even when filter pools are not shown. If you select filters from different
pools, however, then some of the actions in the following procedure might be
disabled.

To learn more about filters and filter pools, see the related concepts. To learn more
about creating filters for z/OS UNIX files, MVS files, or JES jobs, see the related
tasks.

Procedure
v To sort a group of filters:

1. In the Remote Systems view, expand a subsystem and select multiple filters
in the same filter pool.

8. For IDz users, if you want to remove a resource from a subproject, use the Remove from Subproject action in the z/OS Projects
view.

9. For IDz users, you can remove a resource from an MVS subproject. For more information, search for Removing a resource from an
MVS subproject in IDz KC.
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2. Right-click and click Sort. The selected filters are sorted into alphabetical
order.

v To sort a few filters relative to each other, select them individually in the Remote
Systems view, and then right-click and click Sort. The selected filters are sorted,
but the remaining filters are left in their previous order.

v To move a filter in a filter pool or to a different filter pool, you can also drag it.
Related tasks:
“Setting up filters to explore a z/OS UNIX system” on page 27
After you create a connection to an IBM z/OS system, set up filters to explore the
hierarchical file system (HFS) on z/OS UNIX System Services.
“Creating a filter for MVS Files” on page 32
You can define a filter for an MVS system.
“Creating member filters” on page 33
Search for member names and add them to a filter in the My Favorites folder of
the MVS Files subsystem.
“Working with large filters” on page 35
To improve performance for large filters, you can limit the number of data sets that
are displayed in the Remote Systems view.
“Creating a filter for a JES subsystem” on page 71
Define a filter for a JES subsystem.

Accessing z/OS UNIX System Services
After you create a connection to an IBM z/OS system, you might have to configure
this connection to access z/OS UNIX System Services.

Before you begin

Before you can access z/OS UNIX System Services you must create a connection to
an IBM z/OS system.

Procedure

To access z/OS UNIX System Services, complete the following steps:
1. Configure the connection to point to the remote system server.
2. Set the appropriate filters (Root files and Home) to explore the Hierarchical File

System (HFS) on IBM z/OS UNIX System Services.
3. Connect to a remote system server.
4. Optionally, set server launcher preferences for z/OS systems.

What to do next

After the remote system connection is configured, you can use it to browse the
z/OS UNIX System Services files on the remote host. You can also use these files
to populate a project or subproject.
Related tasks:
Creating a connection to a z/OS system
Before you can connect to a remote system from the IBM Explorer for z/OS client,
you must define a connection for it and specify connection properties.
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Configuring a connection to point to the remote system server
After you create a connection to an IBM z/OS system, configure this connection to
access z/OS UNIX System Services by pointing to the remote system server.

Procedure

To configure the z/OS connection to point to the remote system server, complete
the following steps:
1. Change to the RSE perspective.
2. In the Remote Systems view, double-click the z/OS connection to expand it and

reveal the z/OS UNIX Files subsystem.
3. Right-click the z/OS UNIX Files node, and select Properties from the menu to

open the Properties for z/OS UNIX Files dialog box.
4. In the left navigation pane, click Server Launcher Settings to open the Server

Launcher Settings properties page.
5. Do the following option:

Option Description

Click Remote daemon to automatically start
the remote system server by using a server
daemon.

You must start the server daemon by using
the root user ID. If you do not start the
server by using the root user ID, the server
cannot authenticate users who are trying to
connect to the server. In the Daemon Port
field, type the port number that the server
daemon on the remote host uses. By default,
port 6768 is specified.

6. Click OK to save your settings and close the Properties dialog box.
Related tasks:
“Accessing z/OS UNIX System Services” on page 26
After you create a connection to an IBM z/OS system, you might have to configure
this connection to access z/OS UNIX System Services.

Setting up filters to explore a z/OS UNIX system
After you create a connection to an IBM z/OS system, set up filters to explore the
hierarchical file system (HFS) on z/OS UNIX System Services.

Procedure

To set up filters to explore a z/OS UNIX system, complete the following steps:
1. Change to the Remote System Explorer RSE perspective.
2. In the Remote Systems view, double-click the z/OS UNIX Files node to expand

it. The z/OS UNIX Files subsystem has two predefined filters: My Home and
Root.

3. To define a new filter, right-click the z/OS UNIX Files node, and select New >
Filter from the menu to open the New Filter wizard. To change the location
that a filter points to, right-click the filter, and select Properties from the menu.
Switch to the Filter Strings page, and select filter string.

4. To configure the filter to point to a specific directory:
v From the Folder list, select the path.
v In the Folder field, type the path from the root.
v Click Browse to browse for your home directory on the remote system.
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You can use file extensions to specify the file types to narrow down the filter
further.

Tip: The first time that you attempt to access a folder on the remote system,
you are prompted for your user ID and password.

5. Save your changes and close the dialog box.
Related tasks:
“Accessing z/OS UNIX System Services” on page 26
After you create a connection to an IBM z/OS system, you might have to configure
this connection to access z/OS UNIX System Services.

Connecting to a remote system server
After you create a connection to an IBM z/OS system by using the Remote System
Explorer (RSE), you can connect to the remote system server.

Procedure

To connect to the remote system server, complete the following steps:
1. Change to the RSE perspective.
2. In the Remote Systems view, double-click the z/OS connection to activate.
3. Right-click the z/OS UNIX Files subsystem node.
4. Select Connect. The server daemon that you specified on the Server Launcher

Settings properties page is used to start the remote system server for the
connection.

Tip: When you expand a file filter within the Files subsystem, RSE
automatically attempts to establish a connection to the remote system server.
The first time that you attempt to access a folder on the remote system, you
might be prompted for your user ID and password.

Related tasks:
“Accessing z/OS UNIX System Services” on page 26
After you create a connection to an IBM z/OS system, you might have to configure
this connection to access z/OS UNIX System Services.

Setting server launcher preferences for z/OS systems
You can use the Server Launcher Settings preference page to set the default
preferences for the remote server launcher for IBM z/OS connections. You can also
define a different set of preferences for connections to specific z/OS systems by
adding the default remote server launcher preferences for those systems.

Procedure

To set server launcher preferences for z/OS systems, complete the following step:

Set default preferences.
Related tasks:
“Accessing z/OS UNIX System Services” on page 26
After you create a connection to an IBM z/OS system, you might have to configure
this connection to access z/OS UNIX System Services.
Related information:

Creating file filters
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Setting default preferences
About this task

When you create a z/OS connection, you specify server launcher settings on the
z/OS UNIX Files page of the New Remote z/OS System Connection wizard.

The z/OS UNIX Files page is populated with default settings from the Server
Launcher Settings preference page. If default settings for the z/OS system to
connect to are unspecified on this page, the general default settings for all z/OS
systems are used. If you must modify the default preferences, you can change
these settings on the Server Launcher Settings preference page.

Procedure

To modify the default preferences for server launcher settings, complete the
following steps, complete the following steps:
1. In the workbench, click Window > Preferences to open the Preferences

window.
2. In the left navigation pane, double-click the Remote Systems node to open the

tree of available preference pages.
3. From the Remote Systems tree, click z/OS > Server Launcher Settings to open

the Server Launcher Settings preference page.
4. In the Remote Server Launcher Settings section, click Add to open the Remote

Server Launcher Settings dialog box.
5. In the System Name field, type the name of the remote z/OS system to set the

Server Launcher Settings preferences for.
6. Click OK to close the dialog box and add the preferences for this remote z/OS

system to the Remote Server Launcher Settings table.
7. Click Apply to save your selections in the preference page.

Results

These settings are used as the default server launcher settings preferences for the
connection to the specified z/OS system.

Viewing file system information for z/OS UNIX System
Services files or folders

You can view detailed file system information such as input path, mount point, file
system type, file system name, and status for a z/OS UNIX System Services file or
folder.

Procedure

To view detailed file system information for z/OS UNIX System Services files or
folders, complete the following steps:
1. Change to the Remote System Explorer perspective.
2. In the Remote Systems view, double-click the z/OS UNIX Files node to expand

it.
3. Right-click a specific z/OS UNIX System Services file or folder and select

Properties. The File System Info page that includes detailed information is
displayed.
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Setting encodings for z/OS UNIX System Services files
Starting in z/OS Explorer Version 3.1.1, setting the host encoding also tags files by
using the chtag command and you can share the host encoding information with
others. In the z/OS Explorer client, the encoding is determined based on the host
tag information. Therefore, files that were tagged by the chtag command
contribute host encodings without actions. The Properties page shows the
encodings based on tags (if available) and the file transfer operation automatically
uses the tags.

Procedure

To select an encoding for a z/OS UNIX System Services file, complete the
following steps:
1. In the Remote Systems view, right-click a z/OS UNIX System Services file and

select Properties.
2. On the Info page, click Other in the File Encoding section, and select an

appropriate encoding.
3. Click OK.

Results

The z/OS UNIX System Services file on the host is tagged with the new encoding.

Viewing properties of the MVS Files subsystem
The Properties view for the MVS Files subsystem provides quick access to
information about the MVS Files subsystem and your remote system connection10.

About this task

The MVS Files subsystem Properties view displays the following information:

Connected
The connection status of the subsystem: Yes or No.

Name MVS Files.

Number of children
The number of folders, such as My Data Sets, Retrieved Data Sets, My
Favorites, or any other filters you created.

Port The port that is defined for the subsystem during the remote system
connection.

Server Level
The version of the IBM Explorer for z/OS server that is installed on the
z/OS system.

10. For IDz users, the MVS Files subsystem Properties view also displays the following information:

Property Group Name
The name of the property group that is associated with the subsystem.

Property Group Overrides
Whether any values in the property group were overridden: Yes or No.
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SSL Whether the remote system connection was secured with SSL: Enabled or
Disabled.

Type Subsystem.

User ID
The user ID with which you logged in to the remote system.

Version
The version of z/OS installed on the server.

Related tasks:
“Retrieving data sets” on page 36
Use the Retrieve Data Set action to find and add data sets to the MVS Files
subsystem.
“Saving search queries” on page 22
You can save a Remote z/OS Search query and run it from the Remote Systems
view.

MVS Files details view
Use the MVS Files subsystem details view to explore MVS files on the remote
system

About this task

From the Remote Systems view, you can open the MVS Files subsystem details
view. This view displays details about the MVS Files subsystem on the selected
z/OS system.

Procedure

To explore files in the MVS Files subsystem details view:
v To open the MVS Files subsystem details view, do either of the following steps:

1. In the Remote Systems view, select MVS Files and then click Show in Table
on the menu.

2. From the Remote System Details view, double-click the name of the remote
system to which you are connected, then double-click MVS Files.

The MVS Files subsystem contains the following entries:
– My Data Sets - the default MVS files filter.
– Retrieved Data Sets - the last 10 data sets that you searched for by using the

Retrieve Data Set action or added by using the allocate actions.
– Any other MVS file filters that you created.
– My Favorites - any search query results you saved by using the Remote z/OS

Search view.
v To drill down to the MVS files located by each filter, double-click the filter in

this view.
v Use the following icons and menu to lock, unlock, or refresh the view, navigate

through the files and filters in the view, change the columns that are displayed
in the view, or locate a specific resource in the view.
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Option Description

Lock and Unlock Toggles the selected resource between locked
and unlocked status. If the resource is
unlocked, selecting an object in the Remote
Systems view updates the details view.

 
Refresh Refreshes the view.

 
Move Backward and Move Forward Navigates backward and forward among

pages you previously viewed.
 

Move up one level Navigates up the hierarchy of MVS Files,
filters, data sets, and partitioned data set
members.

 
Customize Table Opens the Customize Table window, which

you can use to add, remove, or reorder
columns in the view.

Select Input Switches to a different local or remote object.

Position To Locates the first resource that matches the
string you enter in the Position To window.

Subset Opens the Subset window to select criteria
for limiting the contents that are displayed
in the view.

Creating a filter for MVS Files
You can define a filter for an MVS system.

Before you begin

Before you can create a filter for an MVS system, you must create a connection to
the system. For instructions, see “Creating a connection to a z/OS system” on page
5.

Procedure
1. In the Remote Systems view, under the connection name, right-click MVS Files

and click New > Filter.
2. In the New Filter window, the Filter string field is pre-filled with a variable

&USERID.. You can overwrite the variable. Type the rest of the filter string and
click Next.
The filter string is similar to the data set name level. You can use a single
asterisk to represent zero or more characters. You can use double asterisks “**”
to represent zero or more qualifiers. Given data set names A.C and A.B.C, for
example, the filter A.*.C matches A.B.C, but not A.C, while the filter A.**.C
matches both data set names.
“*” as part of a qualifier means 0 or more characters at this position in the
qualifier, unless it is the last character of a filter. In that case “*” acts like “*.**”
and means that this qualifier must exist and can end with 0 or more characters,
followed by 0 or more other qualifiers.
The only wildcard character that is supported in this field is *. The % wildcard
character is not supported. Usage of a wildcard in the first qualifier is not
supported.

3. In the Filter name field, type a name for your filter and click Finish.. The new
filter is added to MVS Files.
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4. Expand the filter and, when the Enter Password window opens, type your user
ID and password and click OK. If the connection attempt is successful, all the
data sets matching your filter are displayed. You can expand a data set name
and see the members in it.

Creating a filter with selected data sets
You can define a filter with the data sets that you select. The data sets can come
from different filters.

Before you begin

Before you can create a filter for an MVS system, you must create a connection to
the system. For instructions, see “Creating a connection to a z/OS system” on page
5.

Procedure
1. In the Remote Systems view, under the connection name, in MVS Files, expand

the filters that include the data sets that you want to include in the filter, and
use Ctrl+left-click to multi-select them.

2. Right-click on one of the selected data sets, and then click New > Filter from
Data Sets.

3. In the Filter name field, type a name for your filter and click OK. The new
filter is added to MVS Files.

Creating member filters
Search for member names and add them to a filter in the My Favorites folder of
the MVS Files subsystem.

Before you begin

Before you can create a filter for a partitioned data set member, you must create a
connection to a remote system. For instructions, see “Creating a connection to a
z/OS system” on page 5.

About this task

The member filter function is an implementation of Remote z/OS Search. When
you create a member filter, you are creating a query that returns a set of data set
members and saving it to the My Favorites folder of the MVS Files subsystem.

Procedure
1. In the Remote Systems view, expand a z/OS connection name and select MVS

Files.
2. Right-click and select New > Member Filter.
3. In the Filter name field, type a name for the new member filter.
4. In the With name field, type a member name or a search string. You can use

wildcard characters in this field. Valid characters include an asterisk (*) to
match any string, and question mark (?) to match a single character.

Important: To use the ? wildcard character, both the client and server must be
version 3.0 or later.
In a partitioned data set that contains members that are named TEST01, TEST001,
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and TEST0001, the search string TEST*1 matches all those member names. The
search string TEST?1 matches only TEST01.

5. In the Existing filters list, select one or more filters to search for members. To
search in specific data sets, expand the filters and select one or more data sets.

6. Optional: In the Other contexts field, specify a filter string to search. Use this
option to search outside your defined filters. If you initiate a search on one or
more remote resources outside the Remote Systems view, this option is enabled
and specifies <selected resources> as the filter string.

7. Click OK.

Results

The new member filter is added to the My Favorites folder in the MVS Files
subsystem. The Remote z/OS Search view opens and displays the members whose
names match the search string that you defined for the filter.

What to do next

In the Remote z/OS Search view, you can do any actions on the data set members
that you can do in the Remote Systems view.11

If you select a JCL member, you can submit the JCL to JES.

In the Remote Systems view, you can do these actions with the member filter:
v To run the query again, double-click it, or right-click and select Run Query.
v To modify the filter, select it and then select Edit and Run from the menu.

For more information about using the Remote z/OS Search view and saved
queries, see the related topics.
Related tasks:
“Working with search results” on page 17
After you complete a remote z/OS search, the results are reported in the Remote
z/OS Search view. Use this view to sort or filter the search results, edit or browse
returned files, refine the search results, or add returned files to a project or
subproject. 12

“Saving search queries” on page 22
You can save a Remote z/OS Search query and run it from the Remote Systems
view.
“Finding members” on page 38
Use the Find Member action to find partitioned data set members in the MVS
Files subsystem or in a partitioned data set, to open a member in an editor, or to
create a new partitioned data set member.

11. For IDz users, if you select a member that contains COBOL or PL/I source, you can, for example, complete these tasks:

v Edit the member

v Nominate the member as an entry point

v Generate JCL

v Associate a property group with the member

v Show dependencies

v Check the syntax

12. For IDz users, search for Working with search results in IDz KC.

34 IBM Explorer for z/OS : RSE for z/OS User's Guide

https://www.ibm.com/support/knowledgecenter/SSQ2R2/rdz_welcome.html


Working with large filters
To improve performance for large filters, you can limit the number of data sets that
are displayed in the Remote Systems view.

Before you begin

To set preferences for working with large filters, see Setting preferences for MVS
Files subsystems.

About this task

When the default settings for the MVS Files subsystem are in effect and a filter is
expanded, the Remote Systems view displays a maximum of 50 data sets. You can
take the following actions to browse through the data sets.

Note: The examples use a smaller filter for purposes of illustration.

To reduce excessive CPU consumption on the z/OS host, the z/OS system
administrator can limit the number of results that MVS data set filters can return.
If this limit is reached, a warning message IZEA0100W The number of returned
data sets exceeds <limit>. is displayed, where the <limit> is the number of
results specified by the z/OS system administrator. The "Locate" function cannot
locate data sets or members that fall beyond the limit of filter search results.
Modify your MVS data set filters to reduce the number of results they produce so
that the limit is not triggered.

Displaying more data sets
About this task

When you first expand a large filter, the data sets in excess of 50 are shown by
using placeholders.

Procedure
1. To show more data sets, double-click the placeholder. The next 50 data sets are

displayed and a placeholder is shown for the previous 50 data sets.
2. To continue to browse up and down through the data sets, double-click either

the top or the bottom placeholder. You can also browse through data sets by
doing the following actions:
v Select a filter name and then select Navigate > Top, Navigate > Bottom,

Navigate > Previous, Navigate > Next from the menu.
v Select a filter name, data set name, or placeholder and then press the

keyboard shortcuts Ctrl+Home (top), Ctrl+End (bottom), Ctrl+PgUp
(previous), or Ctrl+PgDn (next).

Locating a data set
Before you begin

To use the Locate command, you must set the Sort Order for Data Sets option on
the MVS Files Preference page to By name. Otherwise, the sort order is changed to
By name temporarily until the filter is refreshed.

Procedure

To locate a specific data set, do these steps.
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1. Select the filter name, and then select Locate from the menu or press keyboard
shortcut Ctrl+L.

2. In the Locate Data Set window, specify the data set name that you want to
locate and click OK. You can specify a partial data set name, such as HLQ. If the
name you search for does not exist, the data set name just before the search
string is located. Previous searches are preserved and added to a list in the
Locate Data Set window. You can select a previous search string from this list.
The data set name is displayed and highlighted.

Changing the number of data sets to display
Procedure

To change the numbers of data sets to display for a filter, do one of the following
actions:
v Select a placeholder and then select Show More or Show Less from the menu. A

window opens prompting you to specify the number of data sets to display.
v Select a filter name and then select Properties from the menu. On the Properties

page, select Expansion and specify the number of data sets to display in the
Expansion page size field.

Retrieving data sets
Use the Retrieve Data Set action to find and add data sets to the MVS Files
subsystem.

About this task

The Retrieve Data Set window searches the MVS Files subsystem for data sets that
match a search string that you enter. This function is similar to, but not identical
to, the ISPF option 3.4, Data Set List Utility. The following list shows some of the
differences between Retrieve Data Set and ISPF 3.4:
v Retrieve Data Set does not show data sets that are in the catalog but not on the

volume.
v Retrieve Data Set does not show VSAM data or the index, but shows the VSAM

cluster.
v Retrieve Data Set shows generation data groups under the Retrieved Data Sets

filter. Generation data sets are shown under their respective generation data
groups.

v The wildcard character * functions differently in the Retrieve Data Set window
and ISPF. In the Retrieve Data Set window, an * in a search string can cross
qualifier boundaries. The search string USERID.*O*, for example, matches both
USERID.LOAD and USERID.TEST.COBOL in the Retrieve Data Set window, but
matches only USERID.LOAD in ISPF 3.4.

Procedure
1. In the Remote Systems view, select MVS Files and then select Retrieve Data

Set from the menu or press Ctrl+R. You can also open this window by selecting
any of the following Remote System view resources and pressing Ctrl+R: any
MVS file filter, a sequential or partitioned data set, or a data set member. The
Retrieve Data Set window opens. If you complete previous searches, the last
search pattern that is used is shown in the window.

2. Type a data set name pattern to search for and press Enter. Matching data sets
are listed in the window. The sort order for matches is determined by the Sort
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Order for Data Sets > Remote Systems view setting on the MVS Files
preference page. The window also displays the number of matches.

3. Optional: You can type a new search pattern to update the list of matches. If
you type an invalid data set name pattern, for example, or if you receive many
matches, you can retype or refine the search pattern to try the search again or
narrow down the list of matches.

4. Optional: To find a member of a partitioned data set, select a partitioned data
set name from the data set list and then click the Find Member link or press
Ctrl+F. The Find Member window opens. You can use this window to add a
partitioned data set to the Retrieved Data Sets filter and highlight the member
name, or to open the member in an editor. For more information about using
the Find Member window, see the related links.

5. Optional: To save the search pattern or selected data sets to a new filter:
a. Optional: Select one or more data sets from the list. To select multiple data

sets, hold down the Ctrl key while you select them.
b. Click Add these matches to a new filter. If you select more than one data

set, the New Filter window opens.
c. Type a name for the new filter and click OK.

6. Select one or more data sets and click OK. The data sets are added to the 
Retrieved Data Sets filter in the MVS Files subsystem and the first selected
data set is highlighted in the view. If you selected Add these matches to a new
filter, all matching data sets are added to the new filter and the first selected
data set is highlighted there.

Note: Retrieved Data Sets is a system-controlled filter. By default, it shows
the last 10 data sets found by the Retrieve Data Set action or added by using
the allocate actions. Its unique status is indicated visually by a unique icon: a
filter icon that is superimposed with a pushpin. The only way to populate
Retrieved Data Sets is by using the Retrieve Data Set window or by using the
allocate actions. You cannot rename or delete Retrieved Data Sets, but you can
remove data sets from it and change the number of data sets that are shown in
it. To add search results to a filter that you can rename or delete, use the Add
these matches to a new filter option.

7. To remove a data set from Retrieved Data Sets, select one or more data
sets, right-click, and select Remove from the menu.

Related tasks:
“Managing retrieved data sets”
You can add data sets to or remove data sets from the Retrieved Data Sets folder
of MVS Files and set the maximum number of data sets for this filter. Removing a
data set from Retrieved Data Sets does not delete the data set.
“Finding members” on page 38
Use the Find Member action to find partitioned data set members in the MVS
Files subsystem or in a partitioned data set, to open a member in an editor, or to
create a new partitioned data set member.

Managing retrieved data sets
You can add data sets to or remove data sets from the Retrieved Data Sets folder
of MVS Files and set the maximum number of data sets for this filter. Removing a
data set from Retrieved Data Sets does not delete the data set.
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About this task

Retrieved Data Sets is a system-controlled filter. By default, it shows the last
10 data sets found by the Retrieve Data Set action or added by using the allocate
actions. Its unique status is indicated visually by a unique icon: a filter icon that is
superimposed with a pushpin. The only way to populate Retrieved Data Sets is
by using the Retrieve Data Set window or by using the allocate actions. You cannot
rename or delete Retrieved Data Sets, but you can remove data sets from it and
change the number of data sets that are shown in it. To add search results to a
filter that you can rename or delete, use the Add these matches to a new filter
option.

Procedure

1. To remove a data set from Retrieved Data Sets, select one or more data
sets, right-click, and select Remove from the menu.

2. To manage the Retrieved Data Sets filter, select it, and then right-click and
select Manage from the menu.
a. To remove data sets from the Retrieved Data Sets filter, select the check box

beside the data set name or click Select All.
b. To set the maximum number of data sets that are displayed in this filter, in

the Maximum number of data sets shown in this filter field, specify a
number 1 - 999999999.

Related tasks:
“Retrieving data sets” on page 36
Use the Retrieve Data Set action to find and add data sets to the MVS Files
subsystem.

Finding members
Use the Find Member action to find partitioned data set members in the MVS
Files subsystem or in a partitioned data set, to open a member in an editor, or to
create a new partitioned data set member.

About this task

This task explains how to find a member in the MVS Files subsystem or in a
specific partitioned data set. For information about a quick way to find and open a
member in an editor, see “Finding and editing members” on page 41.

Finding a member in MVS Files
Procedure

To find a partitioned data set member in the MVS Files subsystem:
1. In the Remote Systems view, select MVS Files.
2. Select Find Member from the menu or press Ctrl+F. The Find Member window

opens. The last search pattern that is used for previous searches is shown in the
window.

3. Optional: Press Enter. You can also type a fully qualified data set and member
name pattern to find, for example, USERID.TEST.COBOL(MEM*).

Tip:

v Use * to match multiple characters and ? to match a single character. The *
and ? wildcard characters are allowed only as part of the member name
portion of the pattern and not as part of the data set name.

38 IBM Explorer for z/OS : RSE for z/OS User's Guide



v If the data set name does not exist, a message is displayed.
v No more than one set of parentheses is allowed.
v If extra characters are entered after a valid data set and member name

pattern, an invalid member name pattern message is displayed.
v Normal data set name validation rules and member name validation rules

apply for the specified data set and member name.
v The host encoding (based on either the MVS Files subsystem or the selected

data set) is used for the code variants to be used for data set name and
member name validation.

v If you type the data set name and press the spacebar, parentheses with an
asterisk are added to the pattern field. If you type the data set name
followed by left parenthesis, an asterisk and the closing right parenthesis are
added.

Matching member names are listed in the window. The window also displays
the number of matches.

Note: If the search returns too many member names (the default threshold is
1000 members), a warning message is displayed. You can use the MVS Files
preference page to specify the size of the result set to trigger this warning. For
more information about this preference, see the related links.

4. Optional: Type a new search pattern to update the list of matches. If you type
an invalid member name pattern, if you attempt to access a data set that is
protected by RACF® and that you are not authorized to access, or if you receive
too many matches, you can retype or refine the search pattern to try the search
again or narrow down the list of matches.

5. Optional: To open a member in an editor, do one of the following actions:
v Select a member from the list and click Open Member.
v Type a partitioned data set member name, such as

USERID.TEST.COBOL(MEMBER1), in the entry field and click Open
Member.

Open Member is always enabled to facilitate the quick editing of a data set
member. This button is enabled even when an invalid name message is
displayed. When an invalid member name or pattern is entered in the Find
Member window, the following message is displayed: To open or create a
member, enter a valid member name. The member that you selected is opened
in an editor.

6. Optional: To create a member filter with the member name pattern, select
Create a filter with the member name pattern and click OK. The New
Member Filter window opens. Specify a name for the member filter and click
OK. The new member filter is added to the My Favorites folder of MVS Files
and the matching data set members are displayed in the Remote z/OS Search
view. For more information about member filters, see “Creating member filters”
on page 33.

7. To add a member from this list to Retrieved Data Sets in the MVS Files
subsystem:
a. Select the member that you want.
b. Click OK.

The member that you selected is added to Retrieved Data Sets in the MVS
Files subsystem and highlighted in the view.
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Finding a member in a partitioned data set
About this task

You can also find a member in a specific partitioned data set in the MVS Files
subsystem. 13

Procedure
1. In the Remote Systems view, select a partitioned data set. 14

2. Press Ctrl+F. The Find Member window opens with the data set name in the
field and an asterisk for the member name. For example,
USERID.TEST.COBOL(*).

3. Inside the parentheses, type a member name pattern to find, for example, MEM*
or MEM?0.

4. Press Enter. Matching member names are listed in the window. The window
also displays the number of matches.

5. Continue finding members as described in “Finding a member in MVS Files”
on page 38. When you request the Find Member action for a specific data set,
the member is highlighted under the data set name and not added to the
Retrieved Data Sets filter.15

Creating a member by using the Find Member window
About this task

You can use the Find Member window to create a member in the selected
partitioned data set.

Procedure
1. In the Remote Systems view, select a partitioned data set name.16

2. Press Ctrl+F. The Find Member window opens with the data set name in the
field and an asterisk for the member name. For example,
USERID.TEST.COBOL(*).

3. Type a new member name pattern in the parentheses, for example, MEMBER1.
4. Click Open Member. A window opens asking for confirmation of the creation

of a new member.
5. Click Yes to create the member. The new member is created, opened in the

editor, and highlighted in the Remote Systems view. 17

Related tasks:

Setting preferences for MVS Files subsystems
“Retrieving data sets” on page 36
Use the Retrieve Data Set action to find and add data sets to the MVS Files
subsystem.
“Finding and editing members” on page 41
You can use the Find Member action to quickly find and edit a partitioned data
set member.

13. For IDz users, you can also find a member in a specific partitioned data set in the z/OS Projects view.

14. For IDz users, you can also select a partitioned data set in the z/OS Projects view.

15. For IDz users, if you request the Find Member action from the z/OS Projects view, but the member is not added to the MVS
subproject, it is highlighted in the Remote Systems view.

16. For IDz users, you can also select a partitioned data set name in the z/OS Projects view.

17. For IDz users, the new member is also highlighted in the z/OS Projects view.
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Finding and editing members
You can use the Find Member action to quickly find and edit a partitioned data
set member.

About this task

You can take a shortcut to editing a partitioned data set member from the Find
Member window by typing a specific member name and clicking Open Member
or pressing Alt+O. The member is opened in the editor, and the member list
retrieval process is bypassed.

Note: For complete instructions for using the Find Member window, see “Finding
members” on page 38.

Procedure
1. Open the Find Member window.
2. Type a specific partitioned data set member name and click Open Member or

press Alt+O. The member is opened in an editor. If the member name you type
does not exist, but the name is valid, the Confirm Member Creation window
opens to prompt you to create a data set member and open it in the editor.

Note: Open Member is always enabled to facilitate the quick editing of a data
set member. This button is enabled even when an invalid name message is
displayed. When an invalid member name or pattern is entered in the Find
Member window, the following message is displayed: To open or create a
member, enter a valid member name.

Related tasks:

Setting preferences for MVS Files subsystems
“Retrieving data sets” on page 36
Use the Retrieve Data Set action to find and add data sets to the MVS Files
subsystem.
“Finding members” on page 38
Use the Find Member action to find partitioned data set members in the MVS
Files subsystem or in a partitioned data set, to open a member in an editor, or to
create a new partitioned data set member.

Moving PDS members
You can use the Move action to move a PDS member to another PDS when you
are connected to the server of V3.1 or later.

Procedure
1. Select a PDS member that you want to move.
2. Right-click the member and select Move.
3. Select the destination PDS.

Note: The PDS must not be the original PDS.
4. Click OK. The PDS member is moved to the destination PDS.

Working with large partitioned data sets
To improve performance for large partitioned data sets, you can limit the number
of members that are displayed in the Remote Systems view.
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Before you begin

To set preferences for working with large partitioned data sets, see Setting
preferences for MVS Files subsystems.

About this task

When the default settings for the MVS Files subsystem are in effect and a
partitioned data set is expanded, the Remote Systems view displays a maximum of
50 partitioned data set members. You can take the following actions to browse
through the members of a large partitioned data set.

Note: The examples use a smaller partitioned data set for purposes of illustration.

Displaying more members
About this task

When you first expand a large partitioned data set, the members in excess of 50
are shown by using placeholders.

Procedure
1. To show more members, double-click the placeholder. The next 50 members are

displayed, and a placeholder is shown for the previous 50 members.
2. To continue to browse up and down through the members, double-click either

the top or the bottom placeholders. You can also browse through members by
selecting a member name or placeholder and then pressing the keyboard
shortcuts Ctrl+Home (top), Ctrl+End (bottom), Ctrl+PgUp (previous), or
Ctrl+PgDn (next).

Locating a member
About this task

Locate a member that you want to locate. 18

Procedure

To locate a specific member name, do these steps:
1. Select the partitioned data set name, and then select Locate from the menu or

press keyboard shortcut Ctrl+L.
2. In the Locate Member window, specify the member name that you want to

locate and click OK. You can specify a partial member name, such as MEM. If the
name you search for does not exist, the member name just before the search
string is located. Previous searches are preserved and added to a list in the
Locate Member window. You can select a previous search string from this list.
The member name is displayed and highlighted.

Changing the number of members to display
Procedure

To change the numbers of members to display for a partitioned data set, do one of
the following actions:

18. For IDz users, the Locate menu item is also available on the z/OS Projects view.
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v Select a place holder and then select Show More or Show Less from the menu.
A window opens prompting you to specify the number of members to display.

v Select a partitioned data set name and then select Properties from the menu. On
the Properties page, select Expansion and specify the number of members to
display in the Expansion page size field.

Allocating data sets
Allocating a data set creates a file on the remote system. You can create partitioned
data sets (PDS), libraries (PDSE), version 2 libraries (PDSEv2), and sequential data
sets.

Before you begin

You must be connected to the remote system and working in the Remote Systems
view.

About this task

You can use the New Data Set wizard to allocate these data set types:
v Partitioned data set
v Partitioned data set extended (PDSE)
v Partitioned data set extended version 2 (PDSEv2)
v Sequential data set

These instructions provide general information about using this wizard to allocate
data sets. For more information about a specific data set type, see the related topics
or the context-sensitive help for the wizard.

Fast path: If you have files on the local system, you can quickly add them to a
partitioned data set or allocate a sequential data set by doing one of these steps:
v To add a file to a partitioned data set, drag it from the local system to a

partitioned data set name on the remote system. The Rename Resource window
opens so that you can specify the member name.

v To allocate a sequential data set for a local file, drag it from the local system to a
filter in the MVS Files subsystem. The Rename Resource window opens so that
you can specify the data set name, and the New Data Set wizard opens so that
you can specify data set characteristics.

Procedure
1. Select the MVS Files subsystem in the Remote Systems view. 19

v In the Remote Systems view, expand the remote system where you want to
allocate the data set and select MVS Files.

2. Right-click and select New > Allocate Partitioned Data Set or New > Allocate
Sequential Data Set.

Tip: You can also press Ctrl+1 to allocate a partitioned data set or Ctrl+2 to
allocate a sequential data set.
The New Data Set wizard opens. The remainder of these instructions uses a
partitioned data set as an example.

3. On the Allocate Partitioned Data Set page:

19. For IDz users, you can also select an MVS subproject in the z/OS Projects view.
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a. In the Connection name field, select a remote system connection. The
default value is the connection from which you opened the wizard.

b. In the Data set name field, select or type the high-level qualifier for the
data set from the list and then type the name that follows the combination
of high-level qualifier and dot (.) character. For example, if the high-level
qualifier is MYFILES and if you want to allocate the data set
MYFILES.TEST.COBOL, type the string TEST.COBOL in the field.

c. Click Next.
4. On the Data Set Allocation page, select an option to indicate how to begin

specifying allocation values such as record format, record length, and block
size.
v To use the same data set characteristics as an existing data set, select Copy

characteristics from an existing data set, and then click Browse. Select a
data set, and then click OK.

v To use a defined set of characteristics, select Specify characteristics by usage
type, and then select a value from these lists:
– From the Category list, choose how the data is to be used: Source,

Listing, or Other.
– From the Type list, choose a language: ASM, C/C++, COBOL, JCL, PLI,

or REXX.
v To specify custom data set characteristics, select Specify characteristics

(advanced allocation).
5. Optional: Click Next. The Data Set Characteristics page opens. It displays the

set of data set characteristics that you selected on the Data Set Allocation page:
v For an existing data set: the data set characteristics of the existing data set.
v For usage type: the data set characteristics defined for the selected usage

type.
v For advanced allocation: the values that were used for the previous data set

allocation.
6. Optional: Specify data set characteristics.
v For more information about the fields on this window, see “Data set

characteristics” on page 45.
v For information about the values that are required for different uses, contact

your z/OS system administrator. That administrator can also inform you
whether you must click System Managed Storage to assign a data set to a
particular class.

v The product enforces certain rules for record format (RECFM), record length
(LRECL), and block size (BLKSIZE). For more information about these rules,
see “Data set allocation rules” on page 47.

7. Click Finish. The data set is allocated and added to the Retrieved Data Sets
filter.

Related tasks:

Mapping data sets and partitioned data set members
“Allocating a partitioned data set or sequential file from an existing file” on page
47
You can allocate a partitioned or sequential data set from an existing data set.
“Allocating VSAM data sets” on page 48
Use the Allocate VSAM Data Set wizard to allocate VSAM data sets in the Remote
Systems view.
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“Exploring PDSEv2 member generations” on page 60
Use the PDSEv2 Generations view to browse, compare, copy, and delete
partitioned data set extended version 2 data set member generations.
Related reference:
“Data set characteristics”
You can define data set characteristics when you allocate a data set or view the
characteristics of an existing data set in the data set Properties view.
“Data set allocation rules” on page 47
The IBM Explorer for z/OS product enforces certain rules for record format
(RECFM), record length (LRECL), and block size (BLKSIZE).

Data set characteristics
You can define data set characteristics when you allocate a data set or view the
characteristics of an existing data set in the data set Properties view.

The following list includes some of the data set characteristics that you can set
when you allocate a data set or view in the Properties view when you select a data
set name. In the Properties view, these characteristics are read-only. You cannot set
values for them in this view. Not all of these characteristics are displayed in the
Properties view. If System Managed Storage attributes are not available for a data
set, the Properties view displays **NONE** for those attributes.

Volume serial: The volume serial number (VOLUME) for the storage space on
DASD on which to allocate the data set.

Generic unit: The generic unit name for the device type.

Space units: Defines the unit of primary and secondary space to be allocated. The
default value is BLOCK. Select one of these values:

TRACK: A track of a direct access storage device (DASD).

BLOCK: A block of a DASD.

CYLINDER: A cylinder of a DASD.

Primary quantity: The amount of DASD space to be used for primary space
allocation (PRIMARY). The range depends on the space unit specified and the type
of DASD. The default value is 300.

Secondary quantity: The amount of DASD space to be used for secondary space
allocation (SECONDARY). The range depends on the space unit that is specified
and the type of DASD. The default value is 100.

Extents: The number of contiguous tracks, cylinders, or blocks for primary and
secondary space allocation. Reading or writing contiguous tracks is faster than
reading or writing data that is scattered over the disk.

Directory blocks: Specify the number of directory blocks to allocate. The default
value is 20.

Record format: Choose a record format (RECFM) from the list. For more
information about data set record formats, see the related topics.
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Record length: Specify a logical record size (LRECL) for fixed record formats or a
maximum logical record size for variable record formats. Unformatted records
have no logical record size.

Block size: Specify the physical block size (BLKSIZE) that is written on the disk for
F and FB records. For V, VB, and U records, this value is the maximum physical
block size that can be used for the data set.

Data set type: Choose one of the following types (DSNTYPE): LIBRARY(PDSE),
LIBRARY(PDSEv2), partitioned data set (PDS), or sequential data set (SEQ).

Number of generations: For a PDSE version 2 library, specify the number of
member generations to retain (MAXGENS). When the number of member
generations exceeds this value, older generations are discarded. The default value
is 0.

DSORG: Data set organization, such as physical sequential (PS), partitioned (PO),
or direct access (DA).

Expiration date: You can specify a date on which the data set is automatically
deleted. Use this format: YYYYDDD. 2015012, for example, is January 12, 2015.

Extended attribute: Specify whether the data set can support extended attributes
(format 8 and 9 DSCBs). To create such data sets, you can include extended
address volumes (EAVs) in specific storage groups, specify an EAV on the request,
or direct the allocation to an esoteric containing EAV devices. Specify one of these
values:
v no value: The system's default value.
v NO: No extended attributes are available. The data set cannot have extended

attributes (format 8 and 9 DSCBs) or reside in EAS.
v OPT: Extended attributes are optional. The data set can have extended attributes

and reside in EAS.

System Managed Storage: The information you must provide in this field depends
on your business rules and procedures. Your systems administrator can inform you
whether you must click System Managed Storage (SMS) to assign a data set to a
particular class.

Data class: Name of a data class that is defined in your System Managed Storage
(SMS) installation. Do not enter a value on a system without SMS.

Storage class: Name of a storage class that is defined in your System Managed
Storage (SMS) installation. Do not enter a value on a system without SMS.

Management class: Name of a management class that is defined in your System
Managed Storage (SMS) installation. Do not enter a value on a system without
SMS.
Related tasks:
“Allocating data sets” on page 43
Allocating a data set creates a file on the remote system. You can create partitioned
data sets (PDS), libraries (PDSE), version 2 libraries (PDSEv2), and sequential data
sets.
Related information:
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Quick reference: Data set structure (links to the z/OS basic skills information
center)

Data set allocation rules
The IBM Explorer for z/OS product enforces certain rules for record format
(RECFM), record length (LRECL), and block size (BLKSIZE).

When you allocate a partitioned or sequential data set and use the Data Set
Characteristics page of the New Data Set wizard to specify record format, record
length, and block size, the IBM Explorer for z/OS product enforces the following
rules:
v With any value of record format except U, either record length or block size is

required, and both can be specified. A zero value is the same as being
unspecified. If you omit both record length and block size, the wizard prompts
you with the message Record Length: must not be empty or Block Size: must
not be empty.

v If record format is F, FA or FM and both record length and block size are
specified, they must be equal. Either value defaults to the other value. If you
attempt to enter differing values for record length and block size, the IBM
Explorer for z/OS interface prompts you with the message For the selected
record format, the values of record length and block size must be equal
when both are specified.

v If record format is FB, FBA, or FBM, and both record length and block size are
specified, block size must be a multiple of record length. If you specify record
length without block size, OPEN calculates an optimal value for block size that
depends on the device type. If you attempt to enter a value for block size that is
not a multiple of record length, the IBM Explorer for z/OS interface prompts
you with the message For the selected record format, the value of block
size must be a multiple of record length when both are specified.

v If record format is V, VB, VA, VBA, VM, or VBM and both block size and record
length are specified, block size must be at least four more than the record length
value. If you specify record length without block size, OPEN calculates an
optimal value for block size that depends on the device type. It is at least four
more than the record length value. If you attempt to specify a value for block
size that is less than four more than record length, the IBM Explorer for z/OS
interface prompts you with the message For the selected record format, the
value of block size must at least four more than the value of record
length when both are specified.

v If record format is VA, VBA, VM, or VBM, record length must be at least 5. If
you attempt to specify a value for record length that is less than 5, the IBM
Explorer for z/OS interface prompts you with the message For the selected
record format, the value of record length must at least 5.

v If record format is U, block size is required, and record length is disabled. If you
omit block size, the wizard prompts you with the message Block Size: must
not be empty.

Related tasks:
“Allocating data sets” on page 43
Allocating a data set creates a file on the remote system. You can create partitioned
data sets (PDS), libraries (PDSE), version 2 libraries (PDSEv2), and sequential data
sets.

Allocating a partitioned data set or sequential file from an
existing file
You can allocate a partitioned or sequential data set from an existing data set.
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Before you begin

You must be successfully logged on to a remote system.

Procedure
1. Navigate to the partitioned or sequential data set that has the same

characteristics as the one you want to allocate.
2. Optional: Select the data set and open the Property view to be sure that you

have what you want.
3. Select Allocate Like from the menu.

Note: You can also press Ctrl+1 to allocate a new partitioned data set or Ctrl+2
to allocate a new sequential data set.

4. Specify the name of the data set to be allocated.
5. Click Next. On the next wizard page, the selected data set name is shown and

Copy characteristics from an existing data set is selected.
6. Optional: Click Next. The name of the new data set and its characteristics are

displayed for verification purposes. You can change the characteristics if
necessary.

7. Click Finish. The data set is allocated and added to the Retrieved Data Sets
filter.

8. When the data set is allocated, you can work with it as you would with other
data sets.

Related tasks:
“Allocating data sets” on page 43
Allocating a data set creates a file on the remote system. You can create partitioned
data sets (PDS), libraries (PDSE), version 2 libraries (PDSEv2), and sequential data
sets.

Allocating VSAM data sets
Use the Allocate VSAM Data Set wizard to allocate VSAM data sets in the Remote
Systems view.

Procedure
1. Select the MVS Files subsystem of a remote system connection.
2. Right-click and select Menu > Allocate VSAM Data Set.

Note: You can also press Ctrl+4 to allocate a new VSAM data set.
3. On the first page of the wizard:

a. Accept the name that is provided in the Connection Name field.
b. Select or type the high-level qualifier for the data set from the list.
c. In the Data Set Name field, specify the name that follows the combination

of high-level qualifier and period. For example, if the high-level qualifier is
MYFILES and if you want to allocate the data set MYFILES.TEST.VSAM, type the
string TEST.VSAM in the Data Set Name field.

d. Click Next.
4. On page 2, click Specify characteristics (Advanced allocation) and then click

Next to specify allocation values such as VSAM file type, associations, and
cluster attributes.
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5. Specify the allocation values. For field-level help, see the related links. For
details on what values are required for different uses, contact your z/OS
system administrator.

6. To allocate the data set, click Finish.
Related tasks:
“Allocating a VSAM file from an existing file”
Use the Allocate Like menu item to allocate a VSAM file from an existing file.
Related reference:
“VSAM data set characteristics”
You can specify these VSAM data set characteristics when you allocate a VSAM
data set.

Allocating a VSAM file from an existing file:

Use the Allocate Like menu item to allocate a VSAM file from an existing file.

Procedure

1. In the Remote Systems view, select a VSAM file and right-click to display the
menu.

2. From the menu, select Allocate Like.
3. On the first page of the wizard:

a. Accept the name that is provided in the Connection Name field.
b. Select or type the high-level qualifier for the data set from the list.
c. In the Data Set Name field, specify the name that follows the combination

of high-level qualifier and period. For example, if the high-level qualifier is
MYFILES and if you want to allocate the data set MYFILES.TEST.VSAM, type
the string TEST.VSAM in the Data Set Name field.

d. Click Next.
4. On page two, click Copy characteristics from an existing data set and then

click Next to specify allocation values such as VSAM file type, associations, and
cluster attributes.

5. Specify the allocation values. See the related links for field-level help. For
details on what values are required for different uses, contact your z/OS
system administrator.

6. To allocate the data set, click Finish.
Related tasks:
“Allocating VSAM data sets” on page 48
Use the Allocate VSAM Data Set wizard to allocate VSAM data sets in the Remote
Systems view.
Related reference:
“VSAM data set characteristics”
You can specify these VSAM data set characteristics when you allocate a VSAM
data set.

VSAM data set characteristics:

You can specify these VSAM data set characteristics when you allocate a VSAM
data set.

Some information in the following field definitions is taken from VSAM Demystified
(SG24-6105-01). For more information about this publication, see the related links.
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VSAM type: Choose the type of VSAM data set to allocate:

KSDS: Key-sequenced data set. A VSAM data set whose records are loaded by
ascending key sequence and controlled by an index. Records are retrieved and
stored by keyed access or addressed access and new records are inserted in key
sequence because of free space allocated within the data set. Relative byte
addresses of records can change because of control interval or control area splits.

ESDS: Entry-sequenced data set. A data set whose records are loaded without
regard to their contents and whose relative byte addresses cannot change. New
records are added at the end of the data set.

RRDS: Relative record data set. A type of VSAM data set containing fixed length
records which are accessed by relative record number.

Catalog ID: Identifies the integrated catalog facility (ICF) catalog that contains the
entry for this data set. The default is the system catalog search order.

VSAM associations: Providing a name for the data component and index
component of a VSAM data set allows you to process the data portion separately
from the index portion.

Data: Identifies the data component of the data set. The data component is the part
of a VSAM data set, alternate index, or catalog that contains the data records. If the
data name is not specified, it is generated.

Index: Identifies the index component of the data set. Using the index, VSAM is
able to randomly retrieve a record from the data component when a request is
made for a record with a certain key. If the index name is not specified, it is
generated.

Key length: The length of the key field within each data record. Specify a value
from 1 to 255. This field is used by VSAM to build the index. The sum of the key
length and key offset cannot exceed the length of the shortest record.

Key offset: The position of the key within the record. Specify a value from 0 to the
length of the shortest record. The sum of the key length and key offset cannot
exceed the length of the shortest record.

CI size: The size of the control interval for the data component of the data set. A
control interval is a fixed-length area in which VSAM stores records. It is the unit
of transfer between VSAM and disk storage.

Buffer space: The minimum buffer space to be allocated at open time.

Share cross region: Specify how the cluster can be shared among users on one
system:

1: The cluster can be shared by any number of users for read processing or
accessed by only one user for read and write processing.

2: The cluster can be shared by any number of users for read processing and
accessed by one user for write processing.

3: The cluster can be fully shared by any number of users.
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4: The cluster can be fully shared by any number of users, and buffers used for
direct processing are refreshed for each request.

Reuse: Specify YES or NO to indicate whether the data set can be reset to empty
status at open time.

Recovery: Specify YES or NO to indicate whether the storage allocated to your
data component is to be formatted before records are inserted.

Spanned: Specify YES or NO to indicate whether to allow a data record to span
control intervals.

Erase: Specify YES or NO to indicate whether the space occupied by the data set is
to be overwritten with binary zeros when the data set is deleted. Leave this field
blank to use the erase option set when the entry was defined or last altered.

Writecheck: Specify YES or NO to indicate whether the catalog is to be checked by
a direct access device operation called write check when a record is written.

Space units: Defines the unit of primary and secondary space to be allocated. The
default value is TRK. Select one of the following values:

REC: A record of average size.

KB: A kilobyte (1024 bytes).

MB: A megabyte (1048576 bytes).

TRK: a track of a direct access storage device (DASD).

CYL: A cylinder of a DASD.

Primary units: The amount of DASD space to be used for primary space allocation.
The range depends on the Space unit specified and the type of DASD. The default
value is 10.

Secondary units: The amount of DASD space to be used for secondary space
allocation. The range depends on the Space unit specified and the type of DASD.
The default value is 10.

Average recsize: For RRDS, the length of all records in the data set or, for other
data set types, the average length of records in the data set.

Maximum recsize: The maximum length of the data records.

Freespace percent CI: The percentage of each control interval that is to be set aside
as free space when the VSAM data set is initially loaded, during a mass insert, and
after a CI-split.

Freespace percent CA: The percentage of each control area that is to be set aside as
free space when the VSAM data set is initially loaded, during a mass insert, and
after a CI-split.

Volume serial or serials: Specify a volume on which a cluster's components are to
have space.
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CI size: The size of the control interval for the index component of the cluster.

SMS definitions: Storage Management Subsystem is an operating environment
that helps to automate and centralize the management of storage. SMS provides a
storage administrator with control over data class, storage class, management class,
storage group and ACS routine definitions.

Data class: Name of a data class that is defined in your System Managed Storage
(SMS) installation. Do not enter a value on a system without SMS.

Storage class: Name of a storage class that is defined in your System Managed
Storage (SMS) installation. Do not enter a value on a system without SMS.

Management class: Name of a management class that is defined in your System
Managed Storage (SMS) installation. Do not enter a value on a system without
SMS.
Related information:

VSAM Demystified (an IBM Redbooks publication)

Editing a remote file
Before you begin

You must connect to a remote system and locate the file you want to edit.20

You can set several preferences that control what happens when you open a file:
v You can choose the default editor action for MVS files by setting the Default

action for opening MVS files preference on the MVS Files preference page. This
preference setting determines whether a file is opened for editing, viewing, or
browsing when you double-click the file name. If you drag a file from the
Remote Systems view to the editor, however, the file is opened in edit mode in
the default editor that is associated with the file extension. Setting the Default
action for opening MVS Files preference does not change this behavior.

v Opening large files (greater than 2500 KB) can cause out-of-memory errors and a
forced shutdown of the workbench. Use the Show warning message on
opening files setting on the z/OS Solutions preference page to enable IBM
Explorer for z/OS to check the size of files and display a warning when they are
larger than the specified threshold.

Tip: You can check the size of a file before you open it by opening the
Properties view. This view shows the file size for remote resources in bytes or in
kilobytes.

For more information about these preferences, see the related topics.

Procedure
1. To edit a remote file, select a file in the Remote Systems view.
2. Open a file with one of the following ways:
v To edit the file with the default editor, double-click the file or right-click and

select Open from the menu.
v Open the file with a different editor, right-click it and select Open with from

the menu.

20. For IDz users, see this topic on search for Editing a remote file in IDz KC.
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Results

The file opens in the editor. The file is locked on the remote system while you are
editing it.
Related tasks:
“Creating a connection to a z/OS system” on page 5
Before you can connect to a remote system from the IBM Explorer for z/OS client,
you must define a connection for it and specify connection properties.
“Browsing a remote file”
Browsing a file opens it in read-only mode.
“Viewing a remote file” on page 54

Setting preferences for MVS Files subsystems
Related reference:

z/OS Solutions preferences

Browsing a remote file
Browsing a file opens it in read-only mode.

Before you begin

You must be connected to the system and locate the file you want to browse.

You can choose the default editor action for MVS files by setting the Default
action for opening MVS files preference on the MVS Files preference page. This
preference setting determines whether a file is opened for editing, viewing, or
browsing when you double-click the file name. If you drag a file from the Remote
Systems view to the editor, however, the file is opened in edit mode in the default
editor that is associated with the file extension. Setting the Default action for
opening MVS Files preference does not change this behavior.

Note: Opening large files (greater than 2500 kilobytes) can cause out-of-memory
errors and a forced shutdown of the workbench. Use the Show warning message
on opening files setting of the z/OS Solutions preference page to enable IBM
Explorer for z/OS to check the size of any file that is being opened and display a
warning if it is larger than the specified threshold. For more information about this
setting, see z/OS Solutions preferences.

You can check the size of a file before you open it by opening the Properties view.
This view shows the file size for remote resources in bytes (for resources that are
less than 1000 bytes) or in kilobytes (for resources that are greater than or equal to
1000 bytes).

Procedure
1. Select the file in the Remote Systems view. 21

2. From the menu, click Browse. The file is opened in read-only mode for you to
view.

21. For IDz users, you can also select the file in the z/OS Projects view.
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Note: If you browse a load module file, nondisplayable characters that range
from 0x00 to 0x3F and 0xFF are replaced with a dot (.). CRLF characters are
added to the file records. All editor browse functions are available when you
browse a load module file.

Related tasks:
“Creating a connection to a z/OS system” on page 5
Before you can connect to a remote system from the IBM Explorer for z/OS client,
you must define a connection for it and specify connection properties.
“Editing a remote file” on page 52
“Viewing a remote file”

Setting preferences for MVS Files subsystems
Related reference:

z/OS Solutions preferences

Viewing a remote file
Before you begin

You can choose the default editor action for MVS files by setting the Default
action for opening MVS files preference on the MVS Files preference page. This
preference setting determines whether a file is opened for editing, viewing, or
browsing when you double-click the file name. If you drag a file from the Remote
Systems view to the editor, however, the file is opened in edit mode in the default
editor that is associated with the file extension. Setting the Default action for
opening MVS Files preference does not change this behavior.

About this task

Use the View action to open a remote file in an editor without locking the file.22

Note: To open the file in read-only mode, you can use the Browse action. To edit
the file and obtain a lock on the file, you can use the Open or Open With action.

You can see the lock status of a remote file by looking in the Properties view for
the file. A locked file shows a user ID in the Lock Owner row of the properties
table. An unlocked file shows no user ID in this row.

Procedure

To view a remote file:
1. In the Remote Systems view, right-click the sequential data set or partitioned

data set member name and click View.23 The file opens in the default editor.
The Lock Owner field of the Properties view remains empty or, if another user
locked the file, shows the user ID of that user.

2. Change the file, if necessary. Some editor actions that require automatic saves,
such as Save and Syntax Check and Refactor, are disabled when you open a
file by using the View action.

22. For IDz users, the View action opens a file in the z Systems LPEX Editor, COBOL Editor, or PL/I Editor, but does not lock the
file. The View action opens the file in the default editor for that file. If, for example, you most recently opened the file in the z
Systems LPEX Editor, then that is the editor in which the View action opens the file. You can change the file while you are
viewing it, but to save your changes you must specify a new data set member name.

23. For IDz users, you can also do the same task in the z/OS Projects view.
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3. Close the file. If you changed the file, you are prompted to save it by using the
Save As window for the editor in which the file was opened.24

Related tasks:

Setting preferences for MVS Files subsystems

Comparing remote files
You can compare up to three different files on a remote system and copy changes
between the files.

Before you begin

The Text Compare editor uses the Eclipse text editor to compare two files. You can
set preferences for text comparisons by using the Compare/Patch preference
settings. To open this preference page, click Window > Preferences, then expand
the General list item and click Compare/Patch. Using the settings on this page,
you can, for example, select the Ignore white space option to control whether
white-space changes are shown in the compare viewer. You can also set
language-specific preferences for comparing JCL files.25 For more information about
setting text comparison preferences, see the related links.

When you compare remote files from the Remote Systems view,26 the compare
editor performs several file checks to ensure that the files you are comparing are
fundamentally compatible:
v It checks the record format and record length parameters of the two files and

displays a warning if these parameters are different. You have the option of
continuing with the comparison or canceling it.

v If you edit either file, it checks the length of each record, and, when you save
the file, warns you if any record exceeds the maximum record length.

v If you attempt to save a file with records that exceed the maximum record
length, it warns you that the records are truncated and gives you an opportunity
to correct the records. The warning message includes detailed information about
line numbers that exceed the maximum record length.

v It checks whether either file is locked. Locked files are opened in read-only
mode.

v Files that contain characters that cannot be transferred from the remote system
to the local system and back with the given remote and local code pages are
opened as read-only.

Procedure

To compare files on a remote system, do these steps:
1. From the Remote Systems view, select the files and then select Compare With >

Each Other.27 The files open side by side in the Text Compare editor. The editor
locks both files during the Text Compare edit session. If it cannot obtain a lock
on either file, it displays a warning message. You can either cancel the compare

24. For IDz users, changes made to a file opened in the COBOL or PL/I Editor by using the View action can be saved to a local
project only. The changes cannot be saved to a remote system or a remote project. For more information, search for z Systems
LPEX Editor, COBOL Editor, and PL/I Editor in IDz KC.

25. For IDz users, you can also set language-specific preferences for comparing COBOL and PL/I files.

26. For IDz users, you can also compare remote files from the z/OS Projects view.

27. For IDz users, you can also select the files from the z/OS Projects view.
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request or continue with it. If you choose to continue, the file that cannot be
locked is opened in read-only mode. If the files differ either in record format or
in record length, a window opens warning you of the difference and prompts
you to continue with or cancel the comparison. When the files open, the text
compare editor includes line numbers for each file to help you navigate
through the files and locate any lines that exceed the maximum length.

2. Perform any of the following actions on the files:28

v Click 
 

to copy all file changes from left to right.
v Click 

 
to copy all nonconflicting changes from right to left.

v Click 
 

to copy the current change from left to right.
v Click 

 
to copy the current change from right to left.

v Click 
 

to locate the next difference.
v Click 

 
to locate the previous difference.

v Click 
 

to locate the next change.

Note: Next Change locates a block of text that is different between the files
that are being compared, and Next Difference locates a string within a
change block.

v Click 
 

to locate the previous change.
3. To save your changes, press Ctrl+S. If the changes you made cause any records

to exceed the maximum length, a File Truncation Warning opens. You can click
Details on this warning to see a list of specific line numbers and their length.

4. Click Yes to save your files or No to return to the text compare edit session. If
you click No to return to the edit session, the editor positions the file at the
first line that exceeds the record length limit.

Related tasks:
“Setting language-specific preferences for comparing files”
You can set language-specific preferences for comparing JCL files from the menu
bar,29 in the compare editor, or in the apply patch window.

Setting language-specific preferences for comparing files
You can set language-specific preferences for comparing JCL files from the menu
bar,30 in the compare editor, or in the apply patch window.

Before you begin

This topic explains how to set preferences for the Text Compare editor.

About this task

Typically, the sequence number area is in the following location:31

v JCL files: Columns 73-80

28. For IDz users, the compare function uses the Eclipse text editor rather than the z Systems LPEX Editor, so capabilities that are
available when you edit remote files by using z Systems LPEX Editor, are not available.

29. For IDz users, you can also set language-specific preferences for comparing COBOL and PL/I files from the menu bar.

30. For IDz users, you can also set language-specific preferences for comparing COBOL and PL/I files from the menu bar.

31. For IDz users, the sequence number area is typically in the following locations:

v COBOL files: Columns 1-6.

v PL/I files: Columns 73-80.
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Procedure
1. From the menu bar:

a. Click Window > Preferences, and do the following step:32

v Click JCL > Compare/Patch

b. To ignore the sequence area when you compare files, select Ignore sequence
area.

c. To save the settings, click OK.
2. On the toolbar or menu of the compare editor or on the menu of the apply

patch window:

a. To ignore the JCL sequence area, click 
 

or press Alt+Shift+].33

Comparing a file with a previous version
The compare feature can be used to determine the content difference between two
versions of the same file. Some features available in the source editor are also
available when you compare files, such as quick fix.

Procedure
1. Right-click the file to be compared and click Compare with.
2. Select Local History. You can select a previous version of the file on your local

system to compare with the current version. If there is no local history available
to compare, a message is displayed.

3. Double-click the version that you want to compare. Versions are listed by
revision time.

4. The compare editor opens on both files. Differences are highlighted based on
preference settings. You can copy differences from one file to another and use
the various controls in the editor to move from one difference to another. See
Compare editor in IDz KC for details on using the editor.

Copying remote files
You can copy and paste files within a remote system, from one remote system to
another, or between different views of a remote system.

Before you begin

Connect to a remote system. If you are copying between two remote systems,
connect to both systems.

About this task

You can use several methods to copy and paste files from one location to another:
v Select a file and use the Copy and Paste menu actions to copy it from one

location to another.

In COBOL files, the information area is typically the eight columns to the right of margin R, for example, columns 73-80. For
AIX® COBOL, the information area can span columns 73-80 or 253-260 depending on the SRCFORMAT option setting. For MVS
COBOL, the information area is columns 73-80.

32. For IDz users, you can also do one of the following steps:

v Click COBOL > Compare/Patch

v Click PL/I > Compare/Patch

COBOL files: To ignore the information area when you compare files, select Ignore information area.

33. For IDz users, you can also ignore the COBOL information area or the PL/I sequence area in the same way.
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v Drag a file from one location and drop it to another.
v Edit a file and use the Save as menu action to save it to another location.

The default product configuration grants permission to copy remote files from one
location to another in a remote system or between systems. If you notice that the
Copy, Paste, drag, and Save as actions are disabled on a remote system, then that
system might be configured to deny copy and paste permission. Consult your
systems administrator if you have questions about copy and paste permissions on
a remote system.

For instructions for copying files, see these topics:
v “Partitioned data set”
v “Partitioned data set member”
v “Sequential data set” on page 59

Partitioned data set
About this task

You can copy partitioned data sets:
v From one data set to another on the same remote system.
v Between different views of the same remote system. 34

v From one user ID to another on the same remote system. Be sure that you have
RACF permission for both the source user ID and the destination user ID.

The following copy operations are not permitted for partitioned data sets:
v From one remote system to another.
v From a file on the workstation or a z/OS UNIX system to a data set on a remote

system.
v From a remote system to the workstation or to a z/OS UNIX system.

Procedure
1. Select the partitioned data set that you want to copy.
2. Right-click the partitioned data set and click Copy.
3. Select the destination container.
4. Click Paste. If a data set with the same name exists in the destination container,

you are prompted to overwrite or rename the destination data set.
5. If prompted, click Overwrite; or click Rename, type a new name, and click OK.

The new partitioned data set is created with the same data set characteristics as
the source data set. All members in the source data set are copied to the
destination data set. A progress window opens to report the status of the
member copy operation.

Partitioned data set member
About this task

You can copy partitioned data set members:
v From one data set to another on the same remote system.
v Between different views of the same remote system. 35

34. For IDz users, you can copy partitioned data sets between the z/OS Projects view and the Remote Systems view.

35. For IDz users, you can copy partitioned data set members between the z/OS Projects view and the Remote Systems view.
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v From one user ID to another on the same remote system. Be sure that you have
RACF permission for both the source user ID and the destination user ID.

v From one remote system to another.
v From a file on the workstation or a z/OS UNIX system to a data set on a remote

system. You must be sure that the file does not violate the logical record length
(LRECL) or record format (RECFM) of the destination data set. The copy does
not take place if the LRECL and RECFM on the remote system are violated.

v From a remote system to the workstation or to a z/OS UNIX system.

Procedure
1. Select the member or file that you want to copy.
2. Right-click the file and select Copy.
3. Select the destination container.
4. Select Paste. The new member is created in the destination with the same

member name and the same properties.

Sequential data set
About this task

You can copy sequential data sets:
v From one data set to another on the same remote system.
v Between different views of the same remote system. 36

v From one user ID to another on the same remote system. Be sure that you have
RACF permission for both the source user ID and the destination user ID.

v From one remote system to another.
v From a file on the workstation or a z/OS UNIX system to a data set on a remote

system. You must be sure that the file does not violate the logical record length
(LRECL) or record format (RECFM) of the destination data set. The copy does
not take place if the LRECL and RECFM on the remote system are violated.

v From a remote system to the workstation or to a z/OS UNIX system.

Procedure
1. Select the data set you want to copy.
2. Select a destination filter or folder.
3. Select Paste. If the destination is on the same remote system, you are prompted

to name the copy.
4. If you are prompted, type a name.
5. Click OK. The new data set is created on the remote system.
Related concepts:

File encoding, code page conversion, and inheritance
“Copying files with undefined format” on page 60
Restrictions apply when you copy files with undefined format.
Related tasks:
“Copying a load module” on page 60
You can copy a load module from one library to another.

36. For IDz users, you can copy sequential data sets between the z/OS Projects view and the Remote Systems view.
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Copying a load module
You can copy a load module from one library to another.

Procedure
1. In the Remote Systems view, select the load module that you want to copy.
2. Right-click the file and select Copy.
3. Select the destination container that you are copying to on the same remote

system. You can copy a load module in a PDS or a program object in a PDSE
from one program library to another. You can also use the Copy command to
convert files between load modules and program objects. The target library
must be on the same remote system as the load module that is being copied.

4. Select Paste. The new file is created in the new destination with the same file
name and the same properties. If the member exists in the destination, you are
prompted to overwrite the member, rename it, or cancel the copy operation.
If alias processing is enabled and the selected member is an alias or has aliases,
its primary member and all aliases of the primary member are copied. If one of
the copied members exists in the destination, you are prompted to overwrite
the member or cancel the copy operation. For more information about enabling
alias processing, see the related links.
If alias processing is not enabled and the selected member is an alias or has
aliases, the copy operation fails.
For more information about enabling alias processing, see the related links.

Related tasks:

Setting preferences for MVS Files subsystems

Copying files with undefined format
Restrictions apply when you copy files with undefined format.

Files with undefined format (RECFM=U) cannot be copied in IBM Explorer for
z/OS. This restriction applies to the following cases:
v Copying a file with RECFM=U from one remote system to another
v Copying a remote file with RECFM=U to a local file
v Copying a local file to a remote file with RECFM=U
v Copying a remote file with RECFM=U to a remote file with RECFM=F
v Copying a remote file with RECFM=F to a remote file with RECFM=U

Exploring PDSEv2 member generations
Use the PDSEv2 Generations view to browse, compare, copy, and delete
partitioned data set extended version 2 data set member generations.

Before you begin

Connect to a remote system that supports PDSEv2.

About this task

Partitioned data set extended version 2 (PDSEv2) can retain a number of
generations of data set members. Generations of a PDSEv2 member are identified
by numbers. The current generation is always 0, and previous generations are
numbered with positive integers. If a PDSEv2 member has 10 generations, for
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example, the current generation is 0, the oldest generation is 1, and each
subsequent generation number is incremented by 1.

When you allocate a PDSEv2, you specify the maximum number of generations.
The default value is 0. When a PDSEv2 member exceeds the maximum number of
generations, the oldest generation is discarded. Data set I/O functions, such as
read, write, rename, or delete, operate on the current generation.

You can use the PDSEv2 Generations view to browse, compare, copy, and delete
partitioned data set extended version 2 data set member generations. For more
information about PDSEv2 member generations, see the related topics.

Note: Operations that you perform in the PDSEv2 Generations view are different
from similarly named operations in the Remote Systems and z/OS Projects view.
v The Open, Browse, Delete, Copy to the New Generation, Copy, and Compare

With menu items in the PDSEv2 Generations view operate on the selected
generation.

v The Open, Browse, Delete, Copy, and Compare With menu items in the
Remote Systems and z/OS Projects views operate on the current generation.

The Delete menu item, for example, in the PDSEv2 Generations view deletes only
the selected generation. All other generations remain. The Delete menu item in the
Remote Systems and z/OS Projects views deletes the current generation and all
previous generations of the member. The Rename menu item in the Remote
Systems and z/OS Projects views renames the current generation and deletes all
previous generations of the member. The Search menu item in the Remote Systems
and z/OS Projects views searches only the current generation.

Procedure
1. To open the PDSEv2 Generations view:

a. In the Remote Systems view or the z/OS Projects view, select a PDSEv2
member.

b. Right-click and select PDSEv2 Generations.
2. Select one or more member generations, and then right-click and click one of

these menu items. To select multiple member generations, press and hold the
Ctrl key while you make your selections.

Option Description

Open Opens the selected generation in an editor.
This menu item is enabled only when the
current generation (0) is selected.

Browse Opens the selected generation in read-only
mode in an editor. You cannot modify the
content in the editor.

Delete Deletes the selected generation and refreshes
the view. Deleting a generation might create
a gap in generation numbers. This menu
item is available only when previous
generations are selected.

Copy to the New Generation Creates a new generation, copies the content
of the selected generation to it, and refreshes
the view. This menu item is enabled only
when one generation is selected.
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Option Description

Copy Copies the content of the selected generation
to the clipboard. The copy can be pasted as
a new member of a partitioned data set in
the Remote Systems view or z/OS Projects
view.

Compare With > Each Other Opens two generations in the comparison
editor in read-only mode. This menu item is
enabled only when two generations are
selected. Older generations are opened in
read-only mode.

Defining and using data set aliases
You can define aliases for remote data sets and use them in the same way that you
use ISPF data set aliases.

About this task

A data set alias contains a reference to the data set for which it is created. Data set
aliases are displayed in the Remote Systems view 37 with a distinct icon so that you
can easily identify them as aliases and with the original data set name in brackets
beside the alias name.

Data set aliases have properties that are separate from and can be different from
the properties of the referenced data set. When an alias named HLQ.TEST.JCL
references HLQ.TEST.COBOL, for example, the default extension of all members in
HLQ.TEST.JCL is jcl, while the default extension of the members in HLQ.TEST.COBOL
is cbl.

Note: The Remote Systems view supports access to data set aliases that contain
symbolic names. However, defining a new symbolic name is not supported in
z/OS Explorer.

Procedure

To define an alias for a remote data set:
1. From the Remote Systems view, select the data set for which you want to

define an alias.38

2. Click New > Define Alias.
3. In the Define Alias window, select or type a high-level qualifier in the list.
4. In the Alias Name field, type an alias name for the data set and click OK.

What to do next

There are a few differences between the actions you can perform on data set aliases
and the actions you can perform on data sets:
v The rename action is disabled for aliases.
v When you delete an alias, the referenced data set is not deleted. Only the alias is

deleted.

37. For IDz users, data set aliases are also displayed in z/OS Projects view.

38. For IDz users, you can also do the same task from the z/OS Projects view.
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For more information about actions you can perform on aliases, see the related
links.
Related tasks:
“Deleting an alias”
Deleting an alias deletes only the alias name from the catalog. It does not delete
the referenced data set.
Related information:
“Editing a data set alias”
When you edit a data set alias, you need to be aware of how it is being used in
relation to the data set it refers to. Some restrictions apply when the references
data set is also open for editing.

Deleting an alias
Deleting an alias deletes only the alias name from the catalog. It does not delete
the referenced data set.

Procedure

To delete a data set alias, do these steps:
1. Select the data set alias that you want to delete and click Delete. A Delete

Confirmation window opens.
2. To confirm the delete action, click Delete. A message window opens indicating

that the referenced data set is not deleted.
3. Click OK to close the message window. You can suppress the message window

by clicking Don't show this again.

Results

When you delete a referenced data set, its alias entries are also removed from the
catalog.

Editing a data set alias
When you edit a data set alias, you need to be aware of how it is being used in
relation to the data set it refers to. Some restrictions apply when the references
data set is also open for editing.

When you open a data set or its alias for editing, if another alias or the referenced
data set is already open, a message window opens indicating that the data set or
alias cannot be opened for editing.

If a data set alias is added to a project and the project is taken offline, the alias and
the referenced data set can be edited independently. When you take the project
back online, you must reconcile any differences between the alias in your project
and the referenced data set on the remote system.

Note: Browsing a data set alias while the referenced data set is being edited is
allowed.

Viewing and working with generation data groups
You can display and work with generation data groups in the Remote Systems
view.39

39. For IDz users, you can also display and work with generation data groups in the z/OS Projects view.
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Before you begin

You must be connected to a z/OS system with generation data group resources.

About this task

A generation data group (GDG) is a group of related data sets. Each data set within a
GDG is called a generation data set (GDS) or generation. A GDG base is a catalog
entry for a GDG, and represents a GDG. The IBM Explorer for z/OS GDG support
allows for the display and manipulation of GDGs and GDSs in the Remote
Systems view. The Remote z/OS Search view allows for displaying and working
with GDSs. 40

All functions available for data sets are available for GDSs, except the following
functions:

Add a GDG to a subproject
You can add a GDS in a GDG to a subproject and perform any operations
available for a data set, but you cannot add a GDG as a group to a
subproject.

Search with a GDG 
The Search action is disabled for GDGs so that you cannot search in a
GDG. Search results do not include GDGs. Search results do include GDSs,
and you can perform any operation available for a data set.

Copy a GDG
The Copy action is disabled for GDGs. You cannot copy an entire GDG.

Paste to a GDG
The Paste action is disabled for GDGs. You cannot paste a data set into a
GDG.

Rename a GDG
The Rename action is disabled for GDGs. You cannot rename an entire
GDG.

Procedure

For more information about displaying and working with GDGs and GDSs, see the
following topics.
v “Viewing GDGs and GDSs”
v “Defining a generation data group” on page 65
v “Allocating a generation data set” on page 66
Related reference:

Chapter 29, Processing Generation Data Groups, from z/OS DFSMS Using Data
Sets

Viewing GDGs and GDSs
If you are connected to a z/OS system that contains GDGs, these files are
displayed under the MVS Files node of the Remote Systems view.

40. For IDz users, the z/OS Projects view also allows for displaying and working with GDSs.
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Before you begin

You must be connected to a z/OS system with GDG resources.

About this task

In the Remote Systems view, a GDG is shown as a folder that contains GDSs. A
GDS can be a sequential or a partitioned data set. The name of each GDS in a
GDG consists of the GDG name followed by the absolute generation and version
numbers. The generation and version numbers are in the form GxxxxVyy, where
xxxx is an unsigned 4-digit decimal generation number (0001 - 9999) and yy is an
unsigned 2-digit decimal version number (00 - 99).

A GDS can also be accessed by using the GDG name followed by a relative
generation number. The current generation is represented by 0, the previous
generation by -1, and so on. You use +n to allocate a new generation. The allocated
generation number is the current generation + n. The relative generation number
does not count skipped generations. If a GDG contains GDSs A.B.C.G0001V00 and
A.B.C.G0003V00, A.B.C.G0001V00 is A.B.C(-1) and A.B.C.G0003V00 is A.B.C(0).

In the Remote Systems view, a GDS in a GDG is represented by the absolute
generation and version numbers followed by the relative generation number. This
order can be changed by a preference to the relative generation number followed
by the absolute generation and version numbers. They are shown in the order of
the newest generation to the oldest. The succeeding relative generation number or
the absolute generation and version numbers is a label decoration that can be
disabled by a preference setting.
Related tasks:
“Viewing and working with generation data groups” on page 63
You can display and work with generation data groups in the Remote Systems
view.41

“Defining a generation data group”
You can define a new generation data group (GDG) from the Remote Systems
view.
“Allocating a generation data set” on page 66
You can allocate a new generation data set in a GDG from the Remote Systems
view.

Defining a generation data group
You can define a new generation data group (GDG) from the Remote Systems
view.

Before you begin

You must be connected to a z/OS system.

Procedure

To define a new generation data group in the Remote Systems view:
1. Select MVS Files and then click New > Define Generation Data Group on the

menu. The Define Generation Data Group window opens.
2. Complete the fields on this window as follows:

41. For IDz users, you can also display and work with generation data groups in the z/OS Projects view.
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Connection Name
Shows the name of the remote system to which you are connected.

Generation Data Group Name
Specify a name for the GDG. You can select or type a high-level
qualifier in the list. Type the data set name in the entry field.

Limit Specify the maximum number, 1 - 255, of generation data sets (GDS)
that can be associated with the GDG.

Empty Specifies the action to be taken for the catalog entries for the GDG base
when the number of generation data sets in the GDG base is equal to
the limit value and another GDS is to be cataloged. The disposition of
the actual data sets uncataloged from the GDG base is determined by
the setting of the Scratch parameter for the GDG base. If the Empty
option is selected, all GDS entries are removed from GDG base when
you create a new GDS causes the GDG limit to be exceeded. Otherwise,
only the oldest GDS entry is removed.

Scratch
Specifies the action to be taken for a GDS when the data set is
uncataloged from the GDG base as a result of empty processing. If the
flag is selected, the GDS is deleted from all disks it occupies when
uncataloged from the GDG base, regardless of whether it is
SMS-managed or not. Otherwise, if the data set is a non-SMS managed
data set it is not removed from any of the volumes it occupies, and if
the data set is an SMS-managed data set it is recataloged as a
non-VSAM data set, and is no longer associated with the GDG base. It
is not deleted from any of the SMS-managed volumes it occupies.

Owner
Identify the generation data set's owner. If this parameter is not
specified, the user ID is the default owner ID.

Days Specify the retention period for the generation data group that is being
defined. Click for to define the number of days to retain the GDG up to
9999. Click to to define the data until which to retain the GDG in the
form of [yyyy/]mm/dd.. If a retention period is not specified, the
generation data group can be deleted at any time.

3. Click OK to define the new generation data group.
Related tasks:
“Viewing and working with generation data groups” on page 63
You can display and work with generation data groups in the Remote Systems
view.42

“Viewing GDGs and GDSs” on page 64
If you are connected to a z/OS system that contains GDGs, these files are
displayed under the MVS Files node of the Remote Systems view.
“Allocating a generation data set”
You can allocate a new generation data set in a GDG from the Remote Systems
view.

Allocating a generation data set
You can allocate a new generation data set in a GDG from the Remote Systems
view.

42. For IDz users, you can also display and work with generation data groups in the z/OS Projects view.
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Before you begin

You must connect to a z/OS system and define a generation data group.

Procedure

To allocate a new generation data set in the Remote Systems view, do these steps:
1. In the MVS Files note of the Remote Systems view, select a generation data

group and then click New > Allocate Generation Data Set on the menu. The
Allocate Generation Data Set wizard opens.

2. Complete the fields on this wizard as follows:

Connection Name
Shows the name of the remote system to which you are connected.

Generation Data Group
Shows the name of the generation data group in which the new data
set is allocated.

Generation Data Set
Specify either a relative generation number in the form of (+n) or the
absolute generation number in the form of GxxxxVyy. The default is
(+1).

Relative: To create a relative GDS name, select this option and type a
generation number in the field.

Absolute: To create an absolute GDS name, select this option and then
type the generation number in the G field and a version number in the
V field.

3. Click Next to specify data set allocation characteristics.
4. On the Data Set Allocation page, you indicate one of three ways to begin

specifying allocation values such as record format, record length, and block
size. You select one of three options:
v If you select Copy characteristics from an existing generation data set, click

Browse. In the window, expand the entry that identifies the high-level
qualifier, then click the name of a data set that can act as a model for your
new data set. To return to the Data Set Allocation page, click OK or Cancel:
– To retain the name of the model data set, click OK; or
– To avoid retaining any name when you return to the Data Set Allocation

page, click Cancel.
v If you select Specify characteristics by usage type, you select a value from

each of two list boxes:
– The Category list box indicates a type of content: Source, Listing, or Other
– The Type list box gives a further categorization; within Source, for

example, is JCL.43

v If you select Specify characteristics (advanced allocation), the allocation
values for you to customize are the values that were most recently in place.
Use this selection after you allocate the first in a series of equivalently
structured data sets.

5. To open the Data Set Characteristics page (where you set the actual allocation
values), click Next.

43. For IDz users, within Source also are COBOL, PL/I, ASM, REXX.
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6. Specify the allocation values. For details on what values are required for
different uses, contact your z/OS system administrator. The administrator can
also inform you whether you must to click System Managed Storage to assign
a data set to a particular class. IBM Explorer for z/OS enforces certain rules for
record format (RECFM), record length (LRECL), and block size (BLKSIZE). For
more information, see “Data set allocation rules” on page 47.

7. Click Finish to allocate the new generation data set.
Related tasks:
“Viewing and working with generation data groups” on page 63
You can display and work with generation data groups in the Remote Systems
view.44

“Viewing GDGs and GDSs” on page 64
If you are connected to a z/OS system that contains GDGs, these files are
displayed under the MVS Files node of the Remote Systems view.
“Defining a generation data group” on page 65
You can define a new generation data group (GDG) from the Remote Systems
view.

Migrating and recalling data sets
You can migrate a data set to a migration volume, and recall a migrated data set.

About this task

Migrating an MVS data set moves it to a migration volume. Recalling a migrated
MVS data set moves it back to a target volume.

Migrating a data set
Before you begin

Ensure that the remote system supports data set migration and that your user ID is
authorized to migrate and recall data sets.

Procedure
1. In the MVS Files subsystem or in an MVS subproject, select a data set.
2. Right-click and click Migrate. A progress window opens while the data set is

being migrated. After the data set is migrated, its icon changes to 
 

to
indicate its migrated status. In the Properties view for the data set, the Misc >
Type property changes to Migrated Data Set.

Recalling a data set
Procedure

In the MVS Files subsystem or in an MVS subproject, do one of these steps:
1. Right-click a migrated data set, and click HRECALL.
2. Double-click a migrated data set. A confirmation window opens. Click Yes to

recall the data set or No to cancel the operation.

A progress window opens while the data set is being recalled. After the data set is
recalled, its icon changes to indicate that the data set is accessible.
Related information:
HMIGRATE: Migrating data sets

44. For IDz users, you can also display and work with generation data groups in the z/OS Projects view.
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HRECALL: Recalling data sets

Hiding archived data sets
You can hide archived data sets so that they are not displayed under an MVS Files
filter.

Before you begin

The Show Archived Data Sets action is available only when the IBM Explorer for
z/OS server and client are at version 3.0 or later.

About this task

Archived data sets include data sets that were migrated or are on offline volumes.

Procedure

The Remote Systems view normally shows archived data sets.
v To see the status of archived files for an MVS Files filter, right-click the filter.

When the check box beside Show Archived Data Sets is selected, archived data
sets are displayed under the filter. When it is clear, archived data sets are
hidden.

v To hide archived data sets under a particular MVS Files filter, right-click the
filter name and then click Show Archived Data Sets to clear the check box. For
example, to hide archived data sets from the My Data Sets filter, right-click My
Data Sets and click Show Archived Data Sets. This action affects only the
selected MVS Files filter. It does not affect other filters, such as Retrieved Data
Sets.

v To show hidden archived data sets under a particular MVS Files filter,
right-click the filter name and then click Show Archived Data Sets to select the
check box.

Compressing partitioned data sets
Use the Compress or Compress with Backup menu items to compress partitioned
data sets.

About this task

If a partitioned data set runs out of space or if you make multiple changes to a
partitioned data set or its members, you can compress it to reduce the amount of
space it uses. IBM Explorer for z/OS supports two compression actions:
v Compress compresses the data set.
v Compress with Backup creates a backup copy of the data set before you

compress it. If the compression action is successful, the backup copy is deleted.
If the compression action fails, you can use the backup copy to restore the data
set.

The Compress and Compress with Backup actions are valid for partitioned data
sets only. They are not available for PDSE (Library) or sequential data sets.

Procedure
1. In the Remote Systems view, select a partitioned data set and then select

Compress or Compress with Backup.
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v If you select Compress, the data set is compressed.
v If you select Compress with Backup, the Compress with Backup window

opens to prompt you for a backup data set name.
2. Do one of the following steps:

a. To accept the default backup data set name, click OK.
b. To specify a different backup data set name, type a new name and click

OK. If the compression action is successful, the backup data set is deleted.
The backup data set is saved only if the compression action fails.

Members with nonstandard names
Some tools and products create MVS files with nonstandard names. Nonstandard
names do not adhere to MVS file name conventions. IBM Explorer for z/OS
provides settings for displaying these members in the Remote Systems view.

When you enable the Show members with non-standard name option on the MVS
Files preference page, the Remote Systems view displays members with lowercase
names or names that contain nonstandard character sets. The CA Endevor Software
Change Manager, for example, supports file names that begin with numbers. The
Show members with non-standard name preference provides for showing these
file names in the Remote Systems view. You can then use the menu items in the
Remote Systems view to edit, browse, rename, and delete them. You can also
include nonstandard member names in the With name field of the Remote z/OS
Search window.

Restriction: For nonstandard names that contain lowercase characters, only the
Delete and Rename menu items are available in the Remote Systems view. In this
case, local cache cannot be displayed in the Remote Systems view. The Windows
file system is not case-sensitive, and lowercase cache file names might conflict with
similar uppercase file names.
Related tasks:

Setting preferences for MVS Files subsystems
“Searching a remote z/OS system” on page 11
You can search a z/OS system for file names or for files that contain a search
string.

Monitoring jobs with the JES Subsystem
The JES subsystem is a z/OS subsystem that provides you with access to your jobs
in JES.

In the JES subsystem, you can view job status, see job output, and do the following
actions on jobs:
v Cancel
v Purge
v Hold
v Restart
v Release
v Show JCL (SJ)
v Compare with
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Note: If you purge or cancel a job, you must manually refresh the Remote Systems
or Remote System Details view before the job is removed from the view.

Setting JES subsystem preferences
Use the JES preferences page to set default values for connecting to the JES
subsystem.

Procedure
1. From the main menu, select Window > Preferences.
2. In the Preferences window, expand Remote Systems > z/OS and click JES.
3. On the JES preferences page, you can set these options:

Job spool display: Use this option to display the oldest spool entries first (the
default) or the newest spool entries first. You can add custom settings for a
particular system by clicking the button Add. To change custom settings, use
the JES subsystem property page.
Max number of lines to download: The default for the maximum number of
lines of JES job output data sets to download. Because JES job output can be
large, this setting can help improve performance. When you open a job output
data set, if the number of lines in the download exceeds the value of this
setting, you are prompted for the number of lines to download.
Time in seconds to clear the JES job data sets cache: Specify the interval for
refreshing JES job statistics for jobs that are displayed in the Remote Monitor
view.
Where to locate submitted jobs: Use this option to show a submitted job in the
Remote Systems view or the Remote System Details view (table view).
JES job monitor settings: Use this table to set the preferences for the JES job
monitor on specific remote systems.

4. To save the settings, click OK.

Creating a filter for a JES subsystem
Define a filter for a JES subsystem.

Before you begin

Before you can create a filter for a JES subsystem, you must create a connection to
the remote system. See “Creating a connection to a z/OS system” on page 5 for
instructions.

Procedure
1. Expand a remote system connection name, right-click JES, and click New >

New JES Job Filter. The New JES Job Filter wizard opens.
2. On the first page of the New JES Job Filter wizard, type your user ID in the Job

owner field. The default value for this field is &USERID.
3. Optional: Modify other options on this page or accept the defaults (*). You can

specify the following options on this page:
v Job name prefix: Specifies the job prefix. For example, type STC* to display

all jobs with the STC prefix.
v Job status: Specifies the job status. Choose from the following options:

– Active Displays jobs that are actively running.
– Input Displays jobs that are waiting to run.
– Output Displays jobs in output processing.
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– Held Displays jobs with held output.
v Job class: Specifies the job class. Check with your system administrator to

determine which job classes are available for use.
v Job output class: Specifies the job output class.

The only wildcard character that is supported in these fields is *. The %
wildcard character is not supported.

4. Click Next.
5. In the Filter name field, specify a name for this filter to be displayed on the

view and click Finish. The new filter is added to JES. Expand the filter to see
the jobs that match the filter.

The JES Spool Editor
The JES Spool Editor displays job output with syntax coloring for JCL files and
messages. When you hover over MVS data sets and USS paths, you can press Ctrl
to produce hyperlinks that can be clicked to show the resources in RSE views.
When you hover over messages IDs, you can press Ctrl to produce hyperlinks that
can be clicked to display help for the corresponding messages IDs in IBM
Knowledge Center.

You can open the JES Spool Editor by expanding a filter under JES and
double-clicking a job.

Note: Before you open the JES Spool Editor, connect to a remote system.

Retrieving jobs
Use the Retrieve Job action to add jobs to the JES subsystem without defining a
filter.

Procedure
1. In the Remote Systems view, select JES and then select Retrieve Job from the

menu or press Ctrl+J. You can also open this window by selecting any of the
following Remote System view resources and pressing Ctrl+J: any JES filter, a
JES job, or a JES job data set. The Retrieve Job window opens. The field on this
window can be prefilled in two ways:
v If you performed previous searches, the last search pattern that is used is

shown in the field.
v If you submitted a job by using the Submit menu item from the Remote

Systems view45 or by using the submit line command from the z Systems
LPEX Editor, the job ID of the last job that is submitted is shown in the field.

2. Type a job name pattern to search for and press Enter. Matching jobs are listed
in the window. The jobs are sorted by job name and then by job ID so that the
most recent jobs are at the top of the list. The window also displays the number
of matches.

3. Optional: You can type a new search pattern to update the list of matches. If
you type an invalid job name pattern, for example, or if you receive many
matches, you can change the search pattern to try the search again or narrow
down the list of matches.

4. Optional: To save the search pattern as a new filter, click Add these matches to
a new filter.

45. For IDz users, you can also submit a job by using the Submit menu item from the z/OS Projects view.
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5. Optional: To open the job output for a job on the list, select the job name and
click Open.

6. Select the job that you want and click OK. The job that is selected is added to
the Retrieved Jobs filter in the JES subsystem and highlighted in the view. This
filter saves the last five retrieved jobs. If you selected Add these matches to a
new filter, all matching jobs are added to the new filter and the selected job is
highlighted there.

Note: The Retrieved Jobs filter is a system-controlled filter. Its unique status is
indicated visually by a unique icon: a filter icon that is superimposed with a
pushpin. The only way to populate this filter is by using the Retrieve Job
window. You cannot maintain this filter, change its contents, rename it, or
delete it. To add search results to a filter that you can maintain, use the Add
these matches to a new filter option.

Managing retrieved jobs
You can remove jobs from the Retrieved Jobs filter of JES and set the maximum
number of job filter strings that are displayed under this filter. Removing a job
from Retrieved Jobs does not delete the job.

About this task

Retrieved Jobs is a system-controlled filter. By default, it shows the last 10 jobs
that are submitted by using the allocate actions. The only way to populate
Retrieved Jobs is using the allocate actions. You cannot rename or delete the
Retrieved Jobs filter, but you can remove jobs from it and change the maximum
number of job filter strings that are displayed under this filter.

Procedure
1. In the Remote Systems view, under the connection name, expand JES.
2. Right-click Retrieved Jobs and select Manage.
3. Select one or more job filter strings that you want to remove.
4. Specify a number if you want to change the maximum number of job filter

strings that are displayed under the Retrieved Jobs filter.

Working with JES jobs
In the JES subsystem of the Remote Systems view or Remote System Details view,
you can request various job actions.

About this task

In the Remote Systems view, jobs are displayed in a tree view in the format
jobName:jobID[jobStatus]. Active jobs are listed at the top of the filter.

jobName
The job name.

jobID The job ID.

jobStatus
The return code or return information for the job:
v If the job completed, the return code is shown, such as U0000, or U0012.
v If the job is still running, the job status is ACTIVE.
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v If the job is waiting to execute, the position in the JES queue, such as Pos
1 or Pos 2.

v If the job did not complete, because it was canceled, for example, or it
ended abnormally, or contained a JCL error, then that information is
reported, such as CANCELED, ABEND, or JCLERROR. Jobs that ended
abnormally also display an ABEND code, such as ABEND - SOC4.

Jobs in the Remote Systems view or Remote System Details view are identified by
the following icons:
v A job that is run.
v A job that is running.
v A command, such as purge, hold, or cancel, is issued for the job.
v A job file, such as a message log or JCL.

Procedure
1. In the Remote Systems JES subsystem tree view, you can do the following

actions:
v Select a job to display its status in the Properties view. The status line

contains the state of the job and completion status, if available. To display
the job output, double-click the job name in the JES subsystem view.

v Expand a job to see the data sets that are associated with that job. To display
all of the data sets in a single view, double-click the job. If prompted,
indicate the number of lines to download.

v Right-click a job to see all available actions for it.
2. To view jobs in the Remote System Details table view:

a. Right-click the job filter to open the menu.
b. Select Show in Table to display the jobs in the Remote System Details view.

In the table view, jobs are displayed in a spreadsheet format. Each column
represents a job property.

c. To sort the list of jobs by a column, click the column heading.
d. To customize the table view:
v To select the columns that you want to display and specify the order of

the columns, open the toolbar menu and select Customize Table.
v To view only a subset of the jobs that are returned, open the toolbar

menu and select Subset to specify filters for each property.
3. After you submit a job, a dialog is prompted. You can do the following actions

from the dialog:
v Select Locate. The job is displayed in either the Remote Systems view or the

Remote System Details view depending on the preferences.
v Select Notify. The links to the job are displayed in the Remote Console view.

If you select a job link, it does the same thing as Locate.

Displaying job data sets
You can view job data sets in the JES subsystem.

About this task

Job data sets can be viewed individually or together in an editor.
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Restriction: For obtaining up-to-date output for active jobs, getting the active job
output is not supported for JES3 releases earlier than z/OS V1R10. This limitation
is caused by JES API limitations in the earlier releases. Use JES3 release z/OS
V1R10 or later.

Procedure
v To see the list of job data sets in the JES subsystem of the Remote Systems view,

expand JES > jobFilterName > jobName:jobID[jobStatus]. The list of data sets
provides the step name, the procedure step name, the DD name, and the return
code for the step.

v To open the Properties view for a job data set, select the data set name. For more
information about the data set properties for job data sets, see the related topics.

v To see the properties in the Remote System Details view, right-click the job name
in the Remote Systems view and select Show in Table. For more information
about the data set properties for job data sets, see the related topics. In the
Remote System Details view, you can change the order of the column headings,
add or remove columns, and sort the table entries by clicking a column heading.

v To open all data sets together in an editor, double-click the job name or
right-click the job name and select Open. If the number of lines in the download
exceeds the default preference setting for Maximum Number of Lines to
Download, you are prompted for the number of lines to download. The data
sets are opened in the default editor and are read only.

v To open a specific data set in an editor, double-click the data set name or
right-click it and select Open.

Related reference:
“Properties of job data sets”
You can see the properties of a job data set in the Properties view or in the Remote
System Details view.

Properties of job data sets
You can see the properties of a job data set in the Properties view or in the Remote
System Details view.

To see the properties in the Properties view, select a job data set from the Remote
Systems view. To see the properties in the Remote System Details view, select a job
name from the Remote Systems view and then select Show in Table.

The Properties view and the Remote System Details view show the following
properties of job data sets:

Data Set Name
The fully qualified data set name of the job data set.

Date Stamp
The date the data set was created.

DD Name
The data definition name of the data set.

DSID The data set ID number.

Lines in File
The number of lines in the data set.

Name or Resource
The output data set name.
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Number of Children
The number of child nodes in the Remote Systems view. This property is
displayed in the Properties view only.

Proc Step
The procedure step name.

Step Name
The job step name.

Step Return Code
The job step return code.

Time Stamp
The time the data set was created.

Type The data set type. For JES output data sets, the type is JES Data Set. This
property is displayed in the Properties view only.

Resubmitting jobs
Use the Resubmit action to resubmit the JCL for a specific job ID.

Before you begin

You can request the Resubmit action for a specific job ID in the JES subsystem of
the Remote Systems view or the Remote System Details view. Before you can
request this action, you must submit a job and obtain a job ID.

About this task

This menu action is available only when a single job ID is selected. You cannot
request this action for multiple job IDs.

Procedure

To resubmit JCL for a job ID:
1. From the Remote Systems view or the Remote System Details view, open the

JES job filter that contains the job that you want to resubmit.
2. Right-click a job ID and then click Resubmit. The job is submitted to JES. The

Job Resubmit Confirmation window opens and displays the job ID.
3. Optional: To locate the resubmitted job in the Remote Systems view, click

Locate Job. The job ID is added to the Retrieved Jobs filter.
4. Optional: To be notified when the job completes, click Notify. A JES job notify

background job is created and displayed in the lower right corner of the
workbench status bar.
You can click the progress bar to open the job in the progress view. When the
job completes a message is displayed in the lower left corner of the workbench
status bar.
The message is also written to the Remote Console.

Editing and resubmitting jobs
Use the Show JCL (SJ) action to edit and resubmit the JCL for a specific job ID.
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Before you begin

You perform the Show JCL (SJ) action on a specific job ID in the JES subsystem of
the Remote Systems view or the Remote Systems Details view. Before you can
perform this action, you must submit a job and obtain a job ID.

About this task

The Show JCL (SJ) action opens the JCL used to submit a job in an LPEX editor
session. From this edit session, you can modify the JCL and resubmit the job. The
action obtains the JCL from JES; it does not open the data set member that contains
the submitted JCL. If you edit the JCL, you cannot save it to the original data set
member, but you can save it to a local file.

Procedure

To edit and resubmit JCL for a job ID, do these steps:
1. From the Remote Systems view or the Remote Systems Details view, expand or

drill down into JES > My Jobs.
2. Select a job ID and then click Show JCL (SJ). The JCL used to submit the job

opens in the LPEX editor. The edit tab shows the job ID. If an edit session is
already open for the JCL, Show JCL (SJ) does not open a new session, but
brings focus to the open session.

3. Edit the JCL as necessary. When you edit the JCL, an * is displayed on the edit
session tab to indicate that the JCL is changed.

4. To resubmit the job, type submit on the command line of the LPEX editor and
press Enter.

5. To save the edited JCL to a local file, click File > Save as and enter the file path
where you want to save the JCL.

Comparing JCLs of jobs
Use the Compare with action to compare the JCLs for two selected jobs.

Before you begin

Request the Compare with action for two specific jobs in the JES subsystem of the
Remote Systems view or the Remote System Details view.

About this task

The Compare with action opens a Compare window that displays the details of
the selected jobs and a JCL Source Compare window that displays the differences
between the JCLs.

Procedure

To compare JCLs, follow these steps:
1. From the Remote Systems view, expand filters under the JES subsystem to

reveal jobs.
2. Select two jobs that you want to compare, right-click, and select Compare with

> Each JCL (SJ).
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Showing steps for JES jobs
You can view a list of steps that call programs (EXEC PGM statements) for a JES
job. Detailed system information for each step such as start time, stop time, return
code, abend code, CPU usage, and memory usage is displayed.

Procedure
1. In the Remote Systems view, expand a remote system connection name and

JES.
2. Right-click a job and select Show Steps. The Remote Monitor view is

populated with a list of steps.
3. Double-click a step to open the JES JCL in an editor and position it to the

appropriate step.

TSO subsystem
Use the TSO subsystem to submit TSO commands to the remote system.

Issuing TSO commands
You can issue TSO commands on the remote system from your workstation.

Before you begin

Before you issue TSO commands, you must connect to the z/OS system.

Note: If the host is configured to use Legacy ISPF Gateway, the TSO command
shell does not support interactive TSO command submission. If the host is
configured to use Interactive ISPF Gateway, the TSO command shell supports
interactive TSO command submission. Before you use the interactive TSO
command, try whether the interactive mode is supported or ask your z/OS
systems programmer.

Procedure

To issue a TSO EXEC command, follow these steps:
1. In the Remote System view, expand the remote system.
2. Right-click TSO Commands. A menu opens.
3. Select Launch Shell. The TSO command shell opens.
4. In the Command field, type an EXEC command and press Enter. For example,

type exec 'MYUSERID.REXX.SCRIPTS(MYSCRIPT)', where
v MYUSERID is the high-level qualifier
v REXX is the middle-level qualifier
v SCRIPTS is the low-level qualifier
v MYSCRIPT is a REXX script you wrote

The command is sent to the server. Control is returned to you while the
command processes in the background. The result of the command is
displayed.

Related tasks:
“Saving a TSO session” on page 79
You save TSO sessions to retrieve your output later or take advantage of more
editing features, such as Compare (to compare multiple outputs) or Print.
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Saving a TSO session
You save TSO sessions to retrieve your output later or take advantage of more
editing features, such as Compare (to compare multiple outputs) or Print.

Procedure

To save your TSO session, follow these steps:
1. Issue a TSO command from the TSO command shell.
2. Repeat the previous step for as many commands as you want to enter.
3. From the menu in the TSO command shell, select Export Shell Output. A

window opens, prompting you to choose the location on which to save the
output on your workstation. A default file name that you can change is
provided.

4. After you specify the location and file name, click OK. The session output is
saved in the TSO Commands node of the remote system in the Remote Systems
view.

What to do next

To open a saved session and work with the output, double-click the session name
that is listed under TSO Commands. You can print the session or select multiple
saved sessions to compare the outputs of each.
Related tasks:
“Issuing TSO commands” on page 78
You can issue TSO commands on the remote system from your workstation.
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Chapter 4. Working with the JCL Editor

z/OS Explorer supports the text editor for JCL files. The JCL Editor is associated
with the following file extensions: .jcl, .job, and .prc. It provides
language-specific enhancements such as highlighting syntax errors and source
actions.

Getting started with the JCL Editor
To open a file in the JCL Editor, select the file and click Open With > JCL Editor.

To set the JCL Editor as the default editor for JCL file types, click General >
Editors > File Associations. When you make this association, you can double-click
a file to open it in the JCL Editor.

If one of the following conditions is true, the file opens in read-only mode:
v If you open an MVS file that is locked on the MVS Files subsystem, the editor

opens it in read-only mode and issues a locked file warning. A file might be
locked because it is already open by another user or process.

v If an MVS file contains characters that cannot be correctly converted from one
encoding (code page) to another and then back to the original encoding, the file
is opened in read-only mode and the characters that cannot be converted
correctly are highlighted.

v If the Browse action is used to open the file.

Note: Saving an MVS file when some of the line lengths exceed the record length
limit opens a file truncation warning. Continuing with the save results in truncated
lines.

Customization of the editor

To customize the JCL Editor to suit your preference, select Window (on Windows)
or IBM Developer for z Systems (on macOS) > Preferences > JCL.

Editor presentation toolbar

You can control several aspects of the appearance of files in the editor by using the
editor presentation toolbar:
v Toggle Block Selection Mode enables block selection of text. Enabling block

selection changes the editor font to a fixed-width font.
v Show Whitespace Characters displays a small dot for white space characters

and a paragraph mark for end-of-line markers.
v Toggle Hex Editing displays the currently selected text element in

hexadecimal characters at the bottom of the editor page. The hexadecimal text
can be modified.

v Show Source of Selected Element Only displays only the current
highlighted range of code.
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Status Bar

The status bar is at the bottom of the workbench and provides the following
information about files that are open in the editor:
v The read/write indicator displays Writable or Read-Only.
v The edit mode indicator displays Insert or "Overwrite.
v The line:column indicator displays the line and column position of the edit

cursor.
v The toolbox icon displays the status of tooling.

–
 

indicates that tooling is enabled. All editor functions are enabled.
–

 
indicates that tooling is disabled. These functions can be disabled by user

preference, because a file is unavailable, or because of an invalid file
extension. The following editor functions are unavailable when tooling is
disabled: hover information, Open Declaration.

–
 

indicates that tooling is out of sync because of a syntax error in the file.
This warning is displayed when syntax errors are introduced into an open
file. This warning icon is subject to change frequently as you edit a file. The
following editor functions are unavailable or have limited function: hover
information data might be out of sync; Open Declaration might work, but the
location you jump to might be out-of-sync.

–
 

indicates that tooling is still initializing or failed to initialize because of a
syntax error. This error occurs when a file that contains syntax errors is
opened. The following editor functions are unavailable: collapse/expand code
elements, hover information, Open Declaration.

Related reference:
“JCL Editor keyboard shortcuts” on page 97
Keyboard shortcuts are available in the JCL Editor.

Opening files and getting file content
Learn about editor tools for opening files and getting file content.

Opening, browsing, or viewing a file reference
In the JCL editor, you can open a selected file reference in your program in edit,
browse, or view mode. The selected reference must be a valid reference to a
structure.

Before you begin

Ensure that the data sets and members are allocated correctly so that data sets and
members can be located.

Opening and browsing a file reference
Procedure
1. In the editor, highlight the reference to the file that you want to open and

right-click.
2. Click Open file_reference. The file_reference displays the name of the file that is

requested to be opened. The file opens in the editor.
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Viewing a file reference
About this task

The View file_reference action opens a file in edit mode. However, you cannot save
the changes in the same file. You can save the file with a different name.

Procedure
1. Select the reference to the file that you want to open.
2. Right-click and select View file_reference from the menu. The file opens in the

editor.
3. If you modify the file, you are prompted to save the file with another name.

Note: The Save as feature cannot be used to create a member or sequential
data set. The file is saved in your local workspace project.

Opening, browsing, or viewing an include member
In the JCL Editor, you can open a member that is referred to in an INCLUDE
statement in edit, browse, or view mode.

Before you begin

Ensure that the data sets and members are allocated correctly so that include
members can be located. The editor searches for include members in the following
order:
1. The data sets in JCLLIB ORDER elements in the selected INCLUDE statement's JOB

statement.

If the INCLUDE elements cannot be resolved by the parser, the statement is
annotated with a real-time syntax warning on the member name, and the Open,
Browse, and View Member actions are not available.

Opening and browsing
About this task

The Open Member action opens a member in edit mode. The Browse Member
action opens a member in read-only mode.

Procedure
1. In the editor, place the cursor over the MEMBER attribute of an INCLUDE statement

and right-click.
2. Click Open Member or Browse Member. The member opens in the editor.

Viewing
About this task

The View Member action opens a member in edit mode. However, you cannot
save the changes in the same file. You can save the file with a different name.

Procedure
1. Select the reference to the member that you want to open.
2. Right-click and select View Member from the menu. The file opens in the

editor.
3. If you modify the file, you are prompted to save the file with another name.
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Note: The Save as feature cannot be used to create a member or sequential
data set. The file is saved in your local workspace project.

Opening, browsing, and viewing JCL procedures
You can open a JCL procedure that is referred to in a JCL file in edit, browse, or
view mode.

Before you begin

Ensure that the data sets and members are allocated correctly so that members can
be located. The editor searches for data set members in the following order:
1. The data sets in JCLLIB ORDER elements in the selected EXEC statement's JOB

statement.

Opening or browsing a JCL procedure
About this task

The Open JCL Procedure action opens a file in edit mode. The Browse JCL
Procedure action opens it in read-only mode.

Procedure

To open or browse a JCL procedure from the JCL Editor:
1. Select a JCL procedure name in a program file open in the editor and

right-click.
2. From the menu, select Open JCL Procedure or Browse JCL Procedure. The JCL

procedure opens in the editor.

Viewing a JCL procedure
About this task

The View JCL Procedure action opens the JCL procedure in edit mode; however,
you cannot save the changes in the same file. You can save the file with a different
name.

Procedure
1. Select a JCL procedure name in a JCL file open in the editor.
2. Right-click and select View JCL Procedure from the menu. The JCL procedure

opens in the editor.
3. If you modify the file, you are prompted to save the file with another name.

Note: The Save as feature cannot be used to create a member or sequential
data set. The file is saved in your local workspace project.

Opening a declaration
Use the Open Declaration action in the editor to open the reference to a declared
structure in your program. The selected reference must be a valid reference to a
structure.

Before you begin

Copybooks: To set the default action for Open Declaration on copybook files,
open the Preferences window and navigate to Remote Systems > z/OS > MVS
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Files. On the MVS Files preference page, select an action for the Default action for
opening copybooks preference. You can choose one of these actions:
v Open: Opens the file in edit mode.
v View: Opens the file in edit mode, but does not lock the file.
v Browse: Opens the file in read-only mode.

JCL Editor: To open declarations in JCL files that are open in the JCL Editor:
v You must be connected to a remote z/OS system and open a file on the MVS

Files subsystem.

About this task

The Open Declaration action is available for the following element in the JCL
Editor.

Table 3. Elements for which Open Declaration is available

Editor Selected Element

JCL Editor on JCL files A PROC parameter value of an EXEC
statement, a data set name, or a qualified
data set member name

Procedure
1. In the editor, highlight the reference for which you want to locate the

declaration.
2. To open the declaration, do one of the following actions:
v Press F3.
v Right-click and select Open Declaration.
v From the menu bar, select Navigate > Open Declaration.

If the declaration is in the same file as the reference, then the cursor is moved
to the declaration statement. If the declaration is in a folded region, then the
region is unfolded. If the declaration is in another file and the location of the
file that contains the reference can be determined, then the source file is
opened.

3. Hovering the cursor over a variable or procedure causes hover information to
display details about the highlighted element. Hovering the cursor over this
hover information causes a toolbar to be displayed. The toolbar contains a
toolbar button for opening the declaration of the hovered element.

Previewing copy, include, preprocessor, and macro
statements

You can hover the cursor over a copy, include, preprocessor, or macro statement to
preview its content. The content is displayed in a hover information window with
a toolbar that you can use to navigate the information that is displayed.

About this task

The text in the hover information window is displayed in the format and style that
are defined by the Syntax Coloring preference. If there are remote errors or
problems, real-time syntax warnings are displayed and the first problem is
displayed when the hover information window opens. Hovering over a warning
annotation overlays the existing hover information window with another one
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containing the warning information. COPY and INCLUDE statements are
displayed in the hover information window as hyperlinks. Clicking the hyperlink
causes a hover information window for that element to overlay the existing hover
information window.

The toolbar provides navigation within the window.

Procedure
v To open the hover information window, hover the cursor over an element, or

place the caret on the element and press F2.
v To bring focus to the hover information window, press F2.
v To navigate in the hover information window, use the toolbar.

Backward
Return to the previous element after you click a hyperlink.

Forward
Return to previous element after you click Backward.

Next Problem
Go to the next real-time syntax warning or other error.

Previous Problem
Go to the previous real-time syntax warning or other error.

Edit type
Opens the element in a source editor. The element can be a COPY or
INCLUDE statement.

Open Declaration
Opens a user-defined word, variable, or label in an editor and navigates
to it.

Results

The hover information window displays the following language-specific
information and provides tools for editing or navigating:

JCL

INCLUDE statement
The source of the element. References to nested INCLUDE
members are displayed as hyperlinks. Syntax problems that are
found in the elements are annotated.
v To navigate through the linked INCLUDE members, click

Forward and Back.
v To see the text of syntax problems, hover over the annotations.
v To navigate through the syntax problems, click Next Problem

and Previous Problem.
v To open the include member in an editor and navigate to it, click

Edit Include Member.

Note: Source preview in a hover information window is not available for
the PROC statement in the JCL Editor. To see source for a JCL procedure,
use the Open JCL Procedure action.

Inserting code templates into code
Use code templates to include frequently used blocks of code in a program.
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Procedure
1. Click the location where you want the code block. If you know the first few

letters of the code block, you can type them.
2. Press Ctrl+Spacebar. The template window opens with a list of available

templates.
3. To see a preview of the template, click the template name. A text box opens

showing the content of the template
4. Double-click a template name to include it in the source file.

Surrounding selected statements with a code template
Use the Surround With edit menu item to surround selected statements with a
code template. You can create your own templates and customize existing
templates on the Template preference page.

Procedure
1. Highlight the statements to be surrounded with a code template.
2. Click Source > Surround With. A list of templates that are valid for the

selection is displayed.
3. Select the template that you want to insert. The surrounded text is used to

populate any variables in the code template.

Using content assist
JCL content assist is available for syntax elements of each language and for CICS®

variables and EXEC SQL statements. Where possible, user-defined labels and
variables are included in the list of suggested options.

About this task

Content assist cannot provide any proposals for a syntax error until there is
enough valid syntax to suggest options.

Limitations:

v Content assist for compiler directive statements, such as COPY and REPLACE, and
compiler directives, such as CBL, DYNAM, CALLINT, and CALLINTERFACE, is not
robust enough to provide proposals for all parts of these constructs.

v Because of possible memory issues on the client, content assist proposals are
displayed for a limit of 4 IF . . . OR statements. After four statements a
message is displayed and no further content assist proposals are offered. Content
assist is an aid for common or simple code, so complex or layered statements,
such as PERFORM statements within an EVALUATE or WHEN statement, might result
in no proposals.

Procedure
v To use content assist, open a JCL file in the JCL Editor. As you are typing the

code, press Ctrl+Spacebar and select from among the options that are displayed
to complete the code you are typing.

v You can toggle the content assist window between the default pane and
template pane by pressing Ctrl+Spacebar again. If you close the content assist
window and open it again without changing the cursor location, it reopens on
the same pane. For more information about templates, see the related topics.
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Navigating in source files
The JCL Editor provides various ways to navigate to and from variable
declarations, even when a variable is declared in a different file.

Procedure
v To jump to the location of the next or previous language element, use the Go To

> Next Element (Ctrl+Shift+Down) and Go To > Previous Element
(Ctrl+Shift+Up) actions.

v To navigate in a JCL program from a PROC parameter value of an EXEC
statement, a data set name, or a qualified data set member name, do one of the
following actions:
– Right-click the language element, and select Open Declaration from the

menu.
– Position the text cursor on language element and press the F3 key.
– Hover the cursor over the language element, hold down the Ctrl key, and

click.

If the declaration is in the same file as the reference, the editor navigates to the
declaration in the same editor. If the declaration is in a collapsed region, the
region is expanded. If the reference is in another file and the location of the file
can be determined, the source file is opened in a new instance of the editor.

v To open the Outline or Properties view for the file that is open in the editor,
select Show In > Outline or Show In > Properties.

v To navigate the annotations in the editor, use the Next Annotation (Ctrl+.) and
Previous Annotation (Ctrl+,) actions. The types of annotations visited by these
actions can be configured on the Annotations page. To access this preference,
click General > Editors > Text Editor > Annotations or use the menu on the
toolbar.

v To jump to the editor location of your most recent text change, do one of the
following actions:
– Click Navigate > Last Edit Location.
– Press Ctrl+Q.

v To navigate to a specific line number, select Go to Line and type the line
number in the window that opens.

v When you use another view, such as the Outline view, a navigation history entry
is created. To jump to the previous editor locations visited by these navigation
commands, use the Back (Alt+Left) and Forward (Alt+Right) actions. You can
also use the left arrow ( ) icon to go back to a previous location and the right
arrow ( ) icon to move forward. These icons are in the menu bar.

Related concepts:
“Getting started with the JCL Editor” on page 81
To open a file in the JCL Editor, select the file and click Open With > JCL Editor.

Using the JCL Outline view
When you open a file in the JCL Editor, an outline of the file opens in the Outline
view. You can expand or collapse file divisions, sort file divisions by name, or filter
file divisions by name.
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About this task

The divisions in a JCL file are identified by icons in the Outline view:

Icon Outline element

DD statement

EXEC statement

JOB statement

Procedure
v To expand and collapse sections in the Outline view, click 

 
or 

 
next to the

program section you want to expand or collapse. When you place the cursor on
a line in the editor, the outline expands or collapses the corresponding node.

v To sort sibling nodes in the outline in ascending order by name, click .
v To hide parts of the JCL file according to their name:

1. Select Filters from the drop-down menu. The JCL Element Filters window
opens.

2. Type a name pattern in the field. You can use the * and ? wildcard characters
in the filter string. Separate multiple filter strings with commas.

3. Click Ignore case to match strings in upper, lower, or mixed case.
4. Click OK. The Outline view hides any JCL elements that match the filter

strings entered.
5. To show any of these filtered elements, select Filters again, delete the filter

strings from the field, and click OK.

Navigating a source file with quick outline
Open a quick outline to see the structure of JCL files and navigate in files.

About this task

The quick outline opens on top of the JCL Editor. It provides a view of the outline
of a source file and tools for navigating in the file.

Procedure
1. To open the quick outline, click Navigate > Quick Outline or press Ctrl+O.

The quick outline opens on top of the editor. It contains a search filter and an
outline of the content of the editor.

2. To filter the content of the quick outline, type the text that you want to show in
the filter. Elements that contain matching text and their ancestors are shown in
the outline tree. The first matching element is selected in the outline.

3. To close the quick outline and navigate to the selected element in the source
file, press Enter or double-click the element.

Editing JCL text
The JCL Editor provides functions that increase productivity when you edit a file.

Selecting words and phrases

Use the following tips for editing text in the JCL Editor:
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v To select a word, double-click it. The following characters can constitute a word
in a JCL file: letters, numbers, underscore (_), hyphen (-), period (.), and
ampersand (&). Clicking part of a data set name or parameter selects the entire
entity rather than just a single qualifier in the name.

v To select a quoted phrase, double-click immediately after the open quotation
mark or immediately before the close quotation mark.

v To select a phrase in parentheses or brackets, double-click immediately after the
open parenthesis or bracket or immediately before the close parenthesis or
bracket.

Searching text in file

Use the following methods to search for text in the JCL Editor:
v Select and right-click the text in the editor, click Search Text in File from the

menu.
v Invoke the Search Text in File (Ctrl+Alt+F) menu action, and type the text to be

searched.

Note that the search text is case sensitive.

You can select the Restrict search to columns checkbox and restrict the search
within the specified columns. If not enabled, the search will be restricted within
columns 1 and 80 by default. If the checkbox is selected, but no value is specified
in the Start column or End column, the search range is not restricted.

You can also click Advanced File Search to invoke the default File Search dialog.
The search results will be displayed in the Search View.

Tabbing

All Tab key presses are converted into space characters, regardless of the setting
that is defined by Insert spaces for tabs on the Text Editor preference page. The
number of spaces that are inserted corresponds to the Displayed tab width setting
on the Text Editor page. If a file contains a tab character, it is displayed as a single
space, regardless of the Displayed tab width setting.

When you press the tab key for the first time on a line, the tab spacing matches the
indentation of the previous line.

You can define custom tab stops for the JCL Editor on the Editor preference page.
The default tab settings for the JCL Editor are columns 8, 12, 17 and every 4
characters after column 17.

Hyperlinks

Hyperlink detectors, as defined on the General > Editors > Text Editors >
Hyperlinking preference page, display elements as hyperlinks when you hold
down the Ctrl key. The JCL Editor adds hyperlinks to the following elements:
v PROC parameter of EXEC statements
v Data set names and qualified member names in DD statements
v Include members

To display a hyperlink, hold down the Ctrl key. Click the hyperlink to open the
declaration in an editor.
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Expanding and collapsing elements

You can expand or collapse the following JCL language elements:
v DD statements and DD DATA in-stream statements
v EXEC statements
v JOB statements

To collapse a JCL language element, click . To expand a collapsed element, click
. You can preview a collapsed element by hovering the cursor over the expand

icon.

Opening hover information

Hovering the cursor over an INCLUDE statement causes the JCL hover
information to display the structure over the highlighted element. You can press F2
to display information for the selected structure. The hover information contains
real-time syntax warnings if any exist. You can also obtain hover information in an
open hover information window for INCLUDE statements.

Hovering the cursor over the hover information, opens a toolbar at the bottom of
the hover window. The toolbar provides for navigating the hover information and
opening the structure for editing. If the record has a warning or error annotation
that is associated with it, the annotation text is displayed in the hover information.

Showing range of code structure

If the Show range indicator preference is enabled, when the cursor is place on a
line of code, the range of the code structure is indicated by a vertical bar on the
left side of the editor. To show only the current range of code in the editor, click 
Show Source of Selected Element Only. The Show range indicator preference is
on the General > Editors > Text Editors preference page.

Quick fixes

If editor tools are enabled, suggested changes are provided to resolve a warning or
error annotation in the editor.

Validating JCL
Use the Validate JCL action to validate JCL files.

Before you begin

You must be connected to a remote system.

Procedure
1. Open a JCL file in the JCL Editor, and click Source > Validate JCL or press

Alt+V. A dialog pops up for you to select validation types.
2. Select validation types and press OK. You can select multiple validation types

at once. The following validation types are available:
v DSN validation. The JCL Editor scans the file for data set names

(DSNAME/DSN links used in JCL DD statements) and validates whether the
data sets exist.
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Note: If the JCL file contains syntax errors, the results of data set
identification and validation might not be accurate.

v TYPRUN=SCAN validation. The TYPRUN=SCAN validation submits the JCL
with the TYPRUN=SCAN keyword. In turn, JES converts the JCL to
instructions z/OS can understand which includes JCL validation. When the
conversion completes, z/OS Explorer can collect the report that JES creates
on the conversion and make it available to users.

Note: JES will execute embedded operator commands during
TYPRUN=SCAN validation. If there are no JCL syntax errors, z/OS Explorer
can identify // COMMAND=’cmd’ statements and comment them out before
submitting the JCL. z/OS Explorer cannot identify // cmd statements.

3. Double-click the validation message in the Remote Error List view to view
errors and warnings.

Hexadecimal editing
Using the Toggle Hex Editing action in the editor toolbar, you can display the
hexadecimal (hex) values for the selected line of text.

The hex values are displayed at the bottom of the editor in a table format. There
are two rows, the first being the highlighted text and the second the hex value of
the line. You can change the hex values in the table and the change is reflected in
the text. Changes that are made to the character text are also reflected in the hex
representation of the text.

After the hex editing function is enabled, you can select different lines in the file
and the hex representation is shown at the bottom of the editor. To disable hex
editing, click Toggle Hex Editing in the toolbar.

Continuing comments
Use the Toggle Comment Continuation action to scan the selected lines in the
editor a continuation character in column 71.

Procedure
1. Select the lines of JCL that you want to scan. If you do not select any lines,

then only the line that contains the cursor is scanned.
2. Select Source > Toggle Comment Continuation or press Ctrl+Shift+/. The JCL

Editor scans the selected lines for a continuation character in column 71. If it
finds any continuation characters, then all the selected lines are updated to
remove the comment continuation characters. If it finds no continuation
characters, then the default continuation character is added to all selected lines,
even if those lines do not contain JCL statements with trailing comments. The
default continuation character is set on the Typing preference page.

Commenting and uncommenting lines
Use the Toggle Comment action to comment or uncomment the lines that you
select in the JCL Editor.

Procedure
1. Select the lines that you want to comment or uncomment in the JCL Editor. If

you do not select any lines, only the line that contains the cursor is commented
or uncommented.
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2. Select Source > Toggle Comment or press Ctrl+/. The JCL Editor scans the
lines that you select for //* characters in the first three columns. If all lines that
you select contain the //* characters in the first three columns, the //* characters
are removed. If no //* characters are found, the //* characters are inserted into
the first three columns of all lines that you select.

Labeling source lines in the sequence number area
The sequence number area can be used to label a source statement line. The
content of this area can consist of any character in the character set of the
computer.

The sequence number area of a JCL file is columns 73-80. When you enable
sequence number management for JCL files, the location of the text in columns
73-80 is preserved as you modify text to the left of them. It also preserves the
location of any characters in the comment continuation column, column 72.

For more information about enabling sequence number management, see the
related topics.
Related tasks:
“Adding and updating sequence numbers”
If the Manage sequence numbers preference is enabled, sequence numbers can be
added and updated while you edit a file.
“Removing sequence numbers”
Sequence numbers can be removed while you edit a file.

Adding and updating sequence numbers
If the Manage sequence numbers preference is enabled, sequence numbers can be
added and updated while you edit a file.

Procedure
1. Open a file in the JCL Editor.
2. Right-click in the file to open the menu.
3. Click Source > Sequence Numbers > Renumber. If the file does not contain

sequence numbers, they are added. If the file already contains sequence
numbers, the numbers are overwritten.

Related concepts:
JCL Editor: Sequence number handing
The sequence number area can be used to label a source statement line. The
content of this area can consist of any character in the character set of the
computer.

Removing sequence numbers
Sequence numbers can be removed while you edit a file.

Before you begin

Procedure
1. Open a file in the JCL Editor.
2. Right-click in the file to open the menu.
3. Click Source > Sequence Numbers > Unnumber.
Related concepts:
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JCL Editor: Sequence number handling
The sequence number area can be used to label a source statement line. The
content of this area can consist of any character in the character set of the
computer.

Formatting your program
To improve the appearance and readability of your source code, you can set format
specifications. When you set format specifications, you can enter your code
without concern about the format and then use the Format action in the editor to
format the code according to the specifications.

Before you begin

Define format specifications on the Formatter preference page. For instructions, see
the related topics.

Procedure
1. To format an entire source file, right-click in the editor and click Source >

Format.
2. To format a selected block of code:

a. Select the lines of code that you want to format.

Note: If you press Ctrl+A to select all lines, formatting occurs without
warning. If you are editing a large file, the format operation can take a few
minutes.

b. Right-click in the editor and click Source > Format.

Real-time syntax checking of JCL files
The JCL Editor automatically validates the syntax of JCL.

The editor performs real-time syntax checking and provides annotations that
describe the errors. If an error is found, a warning icon ( ) is displayed. To see
the annotation that describes the error, hover your mouse over the icon. The
maximum number of errors that are reported is based on the value that is specified
for the Maximum number of problems reported per compilation unit editor
preference.

You can customize the appearance of the annotations. The default appearance is a
yellow squiggly line under the detected error. To customize, click Window (on
Windows) or IBM Developer for z Systems (on macOS) > on Windows or
EclipseEditor > Text editors > Annotation. Then, select Warnings in the
annotation types list. Change the appearance by selecting values under Show in.
For example, to highlight the error, check the Text as box and select Highlighted
from the menu. Use the Color field to define the highlight color.

To validate the data set names that are referenced in JCL files, select Source >
Validate JCL or press Alt+V in the JCL Editor.

To turn off real-time syntax checking, select Disable syntax parser on the
Real-Time Syntax Checking preference page.

Limitations
v Command and control statements are color coded, but their syntax is not

checked.
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v The syntax of in-stream data is not checked.

Temporarily disabling Real-time syntax checking
The toggle button on the menu bar for Real-time syntax checking can temporarily
disable Real-time syntax checking for JCL files that are edited.

When the button 
is clicked, Real-time syntax checking is disabled.

When the button 
is clicked again after Real-time syntax checking has been disabled, the preference
settings set previously are restored.

For information about other types of hover information available in the editors,
see the following topics:
“Real-time syntax checking of JCL files” on page 94
The JCL Editor automatically validates the syntax of JCL.

Quick fix
The JCL Editor provides suggested changes to resolve a warning or error
annotation in the editor. To use the quick fix function, the Real-Time Syntax
Checking preference must be enabled.

When a quick fix is available for a warning or error annotation, a light bulb icon is
added to the annotation icon. To display the suggested fixes:
v Place the cursor over the highlighted text. A small pop-up window displays the

suggested fixes.
v Place the cursor on the light bulb icon and left-click.
v Place the cursor on the highlighted text and press Ctrl+1.
v Place the cursor over the text, right-click, and select Quick Fix.
v Place the cursor on the highlighted text and click Quick Fix.

If one of the suggestions fixes the issue, select the item. The highlighted text is
replaced with the suggestion.

The table below shows the quick fixes that are available in the JCL editor.

Table 4. Quick fixes available in each editor

Quick fix JCL

Correct misspelled keywords Yes

Correct misspelled variable names No

Add qualifier to ambiguous variable name No

Correct misspelled function name No

Change copybook or include file resolution
settings

Yes

Add a paragraph to PERFORM statement No

Search for copybook or include files Yes
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Submitting a JCL file to JES
You can submit a JCL file to the JES subsystem from the JCL Editor.

Before you begin

You must be connected to a remote system.

Procedure
1. Open a JCL file in the JCL Editor.
2. Right-click and select Submit > remote system name. The job is submitted to

the remote system that you selected. The Job Submission Confirmation window
opens.

3. To locate the job in the Remote Systems view, click Locate Job. The job is
highlighted in the Retreived Jobs folder of the JES subsystem in the Remote
Systems view.

What to do next

For information about working with jobs in the JES subsystem, see the related
topics.

Saving and closing files
Learn about editor tools for saving and closing files.

Preserving round-trip integrity of MVS files
The JCL Editor ensures that characters converted from one encoding (code page) to
another and then back to their original encoding remain unchanged.

When you edit a remote file with the JCL Editor, it looks like you are editing the
file directly on the remote system. In fact, the file is downloaded to a cache in the
local workspace, then saved to the remote system when the editor session ends.
This process of downloading to the workstation and then uploading to the remote
system involves converting the file contents between the remote EBCDIC-based
encoding (for example, IBM-037) and the local ASCII- or Unicode-based encoding
(for example, Cp1252 or UTF-8). z/OS Explorer uses code page mappings to
determine the remote and local encodings, as described in Remote to local file
mapping.

Certain characters do not translate precisely from one code page to another and
then back again, depending on the code pages involved. To ensure round-trip
integrity, the editors open remote files in browse mode so that you cannot corrupt
the file by saving it back to the remote file system. In addition, the characters that
cannot make the round trip with integrity are highlighted.

Note: Setting the workstation code page to UTF-8 can reduce the number of
characters that do not transfer correctly. Local compilers, however, often do not
accept source files in UTF-8.

File truncation warning
The JCL Editor provides a file truncation warning when you attempt to save a
remote or local file that contains lines that exceed the file's record length limit.
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To enable a user defined max length file truncation warning for files in the JCL
Editor, take the following steps:
1. Select Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences from the menu bar.
2. Extend JCL > Editor, and select Save Actions.
3. Under File truncation warning, select Enable maximum line length and

specify the maximum line length allowed before a truncation warning is issued.

An additional check is done when you save a remote file in the JCL Editor, it
checks for any lines that exceed the record length limit.

If any lines exceed either limit, a window opens warning you that these lines are
truncated when the file is saved. Click Yes to continue with the file save operation
or No to return to the editor to fix the lines in question.

For a remote file, if the user defined maximum is longer than the record length
limit, and it is exceeded, two error windows could be seen.

The editor positions the file at the first line that exceeds the record length limit.
Related tasks:
“Setting preferences for editor save actions” on page 99
You can use the Save Action preference page to configure actions that are
performed by the JCL Editor when you save a file.

JCL Editor keyboard shortcuts
Keyboard shortcuts are available in the JCL Editor.

The list of available key bindings in Eclipse depends on many factors, including
what view or editor is selected, whether a window is open, what plug-ins are
installed, and what operating and windowing system is being used.

To obtain a list of available key bindings at any time, click Help > Key Assist. You
can also press Ctrl+Shift+L (on Windows) or +Shift+L (on macOS).

Setting JCL Editor preferences
You can set preferences that control the appearance and function of the JCL Editor.

To open the preference pages for the JCL Editor, do one of the following steps:
v On the main menu bar, select Window (on Windows) or IBM Developer for z

Systems (on macOS) > Preferences.
v In the JCL Editor, right-click and select Preferences.

Setting global editor preferences

The settings under the General category are global settings that apply at the
workbench level.

Preference Description

Appearance > Colors and Fonts The text font and color that are used by the
editor.
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Preference Description

Content Types Associate file extensions with the JCL
content type.

Editors > File Associations Associate one or more editors with a
particular file extension or group of file
extensions and set one editor as the default.

Setting options that are specific to the JCL Editor

Preferences under the JCL category are specific to the JCL Editor. The following
preference pages are available.

Preference Description
For more
information

Editor Set margins and tab stops “Setting margins
and tab stops” on
page 99

Formatter Specify format of code in the
editor, such as capitalization.

“Formatting JCL
code elements”
on page 99

Save Actions Configure editor save actions that
occur when you save a source file.

“Setting
preferences for
editor save
actions” on page
99

Sequence Numbers “Enabling
sequence number
handling” on
page 100

Syntax Coloring Specify the appearance of code
syntax in the editor.

“Setting colors
and fonts for
language
elements” on
page 101

Task Tags Manage task tags that are used
within the editor.

“Setting task
tags” on page
101

Typing Set options that automate file
formatting as you type.

“Setting typing
preferences” on
page 101

Real-time Syntax Checking Set options for real-time syntax
checking of JCL files.

“Setting options
for real-time
syntax checking”
on page 102

Templates Define templates for frequently
used JCL.

“Setting
preferences for
JCL templates”
on page 103

Setting an autosave interval
When the Autosave preference is enabled, JCL Editor periodically saves a local
backup copy of your edit session.
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If your edit session ends abnormally, due for instance to an operating system or
workbench failure, JCL Editor gives you an opportunity to recover your changes
the next time you open the file.
1. Select Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences > JCL > Editor > Autosave.
2. Click the Autosave check box.
3. In Minutes between saves, type the interval between saves.

Setting margins and tab stops
Use the Editor preference page to set margins and tab stops for the JCL Editor.

Procedure
1. Click Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences > JCL > Editor.
2. Set the following options:
v Display Operation Margin Display a vertical margin line at the column

number that is indicated on the Column field.
v Display Continuation Margin Display a vertical margin line at column 16.

For JCL, continued lines must start between columns 4 and 16 (inclusive). If
the continuation occurs within an apostrophe-delimited parameter, the
continued line must begin at exactly column 16. In the Column field, specify
the location of the margin.

v Display Area R Margin Display the right margin area in the editor.
v Custom tab stops Specify tab stop locations for the editor to use in addition

to the tabs specified by the Display tab width field on the Text Editor
preference page.

Formatting JCL code elements
Use the Formatter preference page to specify preferences for formatting code in the
editor.

Procedure
1. Click Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences > JCL > Editor > Formatter.
2. Select the Capitalization tab to specify the type of capitalization to be used for

language elements.
You can select the following capitalization options:
v Uppercase source code
v Uppercase comments

Related concepts:
“Getting started with the JCL Editor” on page 81
To open a file in the JCL Editor, select the file and click Open With > JCL Editor.
“Setting JCL Editor preferences” on page 97
You can set preferences that control the appearance and function of the JCL Editor.

Setting preferences for editor save actions
You can use the Save Action preference page to configure actions that are
performed by the JCL Editor when you save a file.
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Procedure
1. Click Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences > JCL > Editor > Save Actions.
2. Select Perform the selected actions on save to configure the specified save

options for source files.
3. Select Remove trailing whitespace to remove white-space characters from the

end of the text line during a save.
4. Select Format source code to enable the preferences that are set on the

Formatter preference page to be applied during a file save.
5. Select Enable maximum line length to specify the maximum line length that is

allowed before a truncation warning is issued.
6. Click Apply to save your changes.
Related concepts:
“File truncation warning” on page 96
The JCL Editor provides a file truncation warning when you attempt to save a
remote or local file that contains lines that exceed the file's record length limit.
Related tasks:
“Formatting JCL code elements” on page 99
Use the Formatter preference page to specify preferences for formatting code in the
editor.

Enabling sequence number handling
Use the Sequence Numbers preference page to specify how sequence numbers are
handled when you edit a file.

Procedure

You can open the Sequence Numbers page from the menu bar or from an edit
session.
1. From the menu bar, click Window (on Windows) or IBM Developer for z

Systems (on macOS) Preferences, and then do the step: Click JCL > Editor >
Sequence Numbers.

2. From an edit session, right-click and select Source > Sequence Numers >
Preferences.

Tip: To enable sequence number handling from an edit session without
changing any of the preference settings, click Source > Sequence Numers >
Manage Sequence Numbers. This action enables sequence number handling,
but does not open the preference page.

3. To enable sequence number management, select the Manage sequence
numbers check box.
Select one or more of the following options.

Enable Smart Copy
Text in the sequence number and identification areas is replaced by
spaces when you copy the text. If Insert sequence numbers into new
lines is enabled, lines that are pasted into the file are renumbered.

Enable Smart Join Lines
Text in the sequence number and identification area and trailing white
spaces are deleted when lines are joined.
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Insert sequence numbers into new lines
Sequence numbers are inserted when you add new lines to a file.

Resequence numbers when necessary
This option controls what happens when Insert sequence numbers into
new lines is enabled but there are not enough available numbers at the
location where the new lines are inserted into the file. If this option is
selected, surrounding lines are renumbered. If this option is cleared, no
sequence numbers are added to the inserted lines.

4. Click OK.

Setting colors and fonts for language elements
Use the Syntax Coloring preference to associate colors and selected font styles with
language elements. For example, comments can be defined to display in green. The
setting on this preference overrides any setting on the Colors and Fonts preference.

Procedure
1. Click Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences.
2. Expand the categories to JCL>Editor>Syntax Coloring.
3. From the Elements field, select a language element.
4. To select the color that you want for the element, click the color button and

then click OK to save your selection. The results of your selection are displayed
in the Preview field.

5. Click Apply to save your changes.

Setting task tags
Use the Task Tags preference page to define customized tags for use with the
editor. For example, you can define tags to identify actions that you want to
complete later.

Procedure
1. Click Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences > JCL > Editor > Task Tags > New.
2. Type the name of the tag in the Tag field. Assign a priority for the task from

the menu in the Priority field and click OK.
3. If you want your tag to be case-sensitive, ensure that the Case sensitive task

tag names check box contains a check mark.
4. Click Apply to save your changes.
Related concepts:
“Getting started with the JCL Editor” on page 81
To open a file in the JCL Editor, select the file and click Open With > JCL Editor.
“Setting JCL Editor preferences” on page 97
You can set preferences that control the appearance and function of the JCL Editor.

Setting typing preferences
Use the Typing preference page to set options that automate file formatting as you
type in a JCL file.
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Procedure
1. Click Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences > Editor > Typing.
2. In the Automatically continue statement area, you can enable options for

adding "//" and the appropriate indentation to new lines. The following
descriptions explain the effect of enabling these options. Each of these options
is enabled by default.

Within a continuing comment field
When you insert a new line after the trailing comment of a JCL
statement, and that statement has a continuation character in column
71, then the new line is prefixed with “//” and the indentation of the
new line is adjusted to match the indentation of the previous line.

Within a quoted string or after an unclosed quoted string
When you insert a new line within a quoted string or after an unclosed
string (a line that has no end quotation at the end), then the new line is
prefixed by “//” and the new line is indented to column 16.

After an incomplete parameter list
When you insert a new line after a comma in a JCL statement
parameter list, and before another character that is part of the
parameter list, the new line is prefixed by “//” and the indentation of
the new line is adjusted to match the indentation of the previous line.
The line is not indented past column 16.

3. In the Comment fields area, you can enable options for adding comments to a
JCL file.

"Toggle Comment Continuation" chacacter
Specify a character to be used as the continuation character. This field
must not be blank. For more information about the Toggle Comment
Continuation action, see the related topics.

Copy continuation character into the current line
When you insert a new line into a trailing comment of a JCL statement,
and that statement has a continuation character in column 71, then the
line that is split is padded with spaces up to column 71. The same
continuation character that used to be on that line is inserted into the
new line. The new line contains the original continuation character. The
original continuation character remains in column 71 only if the
Manage sequence numbers preference is enabled. For more
information about the Manage sequence numbers preference, see the
related topics.

Related tasks:
“Enabling sequence number handling” on page 100
Use the Sequence Numbers preference page to specify how sequence numbers are
handled when you edit a file.

Setting options for real-time syntax checking
You can set preferences that control whether the editor checks syntax while you
edit a file. Warning annotations assist with making corrections to identified errors.
Disabling the syntax parser causes any tooling that is dependent on it to be
disabled. The maximum number of problems that are reported is 200.
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Procedure
1. Click Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences.
2. Choose JCL > Real-Time-Syntax Checking to set preferences for the JCL Editor.
3. To enable real-time syntax warnings to identify programming errors while you

edit, select the Enable real-time syntax warnings check box.
4. If real-time syntax warnings are enabled, you can specify the maximum

number of errors that are reported during an edit session. Specify an integer 1 -
200 for the Maximum number of problems reported per compilation unit
field. The maximum includes the file content and referenced copybook or
include members.

5. To validate the data set names that are referenced in JCL files, select Source >
Validate JCL or press Alt+V in the JCL Editor.

6. To disable the syntax parser, click the Disable syntax parser check box.
7. COBOL 6.2 adds conditional compiler statements. If those statements are inside

copybooks, you need to load copybooks synchronously. To load Copybooks
synchronously, click the Load Copybooks synchronously check box.

8. Click Apply to save your changes.
Related concepts:
“Real-time syntax checking of JCL files” on page 94
The JCL Editor automatically validates the syntax of JCL.

Setting preferences for JCL templates
The JCL Editor supports the use of templates to promote efficiency and consistency
in creating commonly and frequently used JCL. The Templates preference allows
for the creating, editing, removing, importing, and exporting of JCL templates. A
default set of templates is provided with the product.

Before you begin

Code templates are among the Eclipse preferences that can be exported to a remote
system and distributed to clients by using the push-to-client feature. Before you
create or edit code templates, be sure that you know which templates are local
(created on your workstation) and which are remote (delivered to your workstation
by using push-to-client). If you edit a remote template but do not give it a unique
name, your edits might be overwritten when you connect to the remote system.

For more information about how the push-to-client feature merges local and
remote templates, see “Code templates in a push-to-client environment” on page
104.

Procedure
1. Click Window (on Windows) or IBM Developer for z Systems (on macOS) >

Preferences > JCL.
2. Click Templates.

Template table
The table list templates by name and associated context. It also contains
a brief description. The Context indicates the section of a source file in
which the template is valid. The check box beside the template name
indicates whether the template is enabled and available for use.
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Preview
Select a template in the table to see the content of the template.

3. Click Restore Defaults to remove any changes that you made and restore the
list to the original defaults.

Related concepts:
“Getting started with the JCL Editor” on page 81
To open a file in the JCL Editor, select the file and click Open With > JCL Editor.
“Setting JCL Editor preferences” on page 97
You can set preferences that control the appearance and function of the JCL Editor.

Related tasks:
“Inserting code templates into code” on page 86
Use code templates to include frequently used blocks of code in a program.

Code templates in a push-to-client environment
Code templates are among the Eclipse preferences that can be exported to a remote
system and distributed to clients by using the push-to-client feature. Before you
create or edit code templates, be sure that you know which templates are local
(created on your workstation) and which are remote (delivered to your workstation
by using push-to-client). If you edit a remote template but do not give it a unique
name, your edits might be overwritten when you connect to the remote system.

When you connect to a remote system that has the push-to-client feature enabled,
any Eclipse preferences that have been exported from the master workspace are
downloaded to your client workspace. Among the preferences that can be
downloaded to a client workspace is the JCL template. z/OS Explorer can
determine which templates originate in your client workspace (local templates) and
which originate on the remote system (remote templates). z/OS Explorer preserves
your local templates and updates the remote templates.

z/OS Explorer uses a combination of physical location and template name to
determine which templates are local, which templates are remote, and how to
merge them during a push-to-client operation. z/OS Explorer does not examine
template content. It relies solely on template names to determine whether to
replace a local template with a remote template.

Tip: When you create remote templates for downloading in a push-to-client
environment, consider establishing a convention that indicates that the templates
originate on a remote system. You might, for example, include the suffix
"REMOTE" in the template name or add a description, such as, "Downloaded from
sample.systemz.connection.com" or "Remote template; do not edit."

These rules govern how local and remote templates are merged:
1. If a local template has the same name as a remote template, it is overwritten

with the remote template.
2. If multiple local templates have the same name as a remote template, the local

templates are discarded and replaced with the remote template.
3. The push-to-client operation can only add and replace templates on the client

workspace. It cannot delete templates. If a template name is deleted from the
remote system, but not from the client workspace, it remains in the workspace
after the push-to-client operation.

4. If a remote template is renamed on the client workspace after it is downloaded
so that its name no longer matches any of the remote templates, it is not
overwritten during a push-to-client operation.
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Examples

The following examples describe several scenarios for merging local and remote
templates during a push-to-client operation. Each example describes a list of
template names in a client workspace, a list of template names on a remote system,
and the list of merged templates on the workstation after a push-to-client
operation.

In these examples, templates that have the same name are differentiated by prime
(′), double-prime (′′), and triple-prime (′′′) symbols. The following example involves
three templates named A: A is on the client workspace and A′ and A′′ are on the
remote system. After a push-to-client operation, Template A is replaced by
templates A′ and A′′. The user who is seeing the templates in the user interface,
sees only that the client workspace now contains two templates named A. The
content of these templates is replaced by the content of the templates on the
remote system.

Local Templates Remote Templates Merged Templates

A A′, A′′ A′, A′′

Example 1: No local templates

No templates are defined on the client workspace. When a user connects to the
remote system, remote templates A and B are downloaded to the client workspace.

Table 5. No Local Templates

Local Templates Remote Templates Merged Templates

[none defined] A, B A, B

Example 2: Merge

Template C is defined on the client workspace. Templates A and B are defined on
the remote system. When a user connects to a remote system, templates A and B
are added to the client workspace.

Table 6. Merge

Local Templates Remote Templates Merged Templates

C A, B A, B, C

Example 3: Merge and replace

Template A is defined on the client workspace. Templates A and B are defined on
the remote system. When a user connects to the remote system:
v Template A on the remote system replaces template A on the client workspace.
v Template B is added to the client workspace.

Table 7. Merge and replace

Local Templates Remote Templates Merged Templates

A A′, B A′, B
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Example 4: Merge and replace

Templates B and C are defined on the client workspace. Templates A and B are
defined on the remote system. When a user connects to the remote system:
v Template A is added to the client workspace.
v Template B on the remote system replaces template B on the client workspace.
v Template C remains on the client workspace.

Table 8. Merge and replace

Local Templates Remote Templates Merged Templates

B, C A, B′ A, B′, C

Example 5: Reconnecting to a remote system

No templates are defined on the client workspace. Templates A and B are defined
on the remote system.
1. The first time a user connects to the remote system, templates A and B are

downloaded to the client workspace.
2. The user renames template B to BB and creates templates C and D. On the

remote system, template A is deleted and template C is created.
3. The user disconnects from the remote system.
4. When the user connects to the remote system again:
v Template A remains on the client workspace
v Template B is downloaded to the client workspace
v Template BB remains on the client workspace
v Template C is replaced on the client workspace
v Template D remains on the client workspace

Table 9. Two connections

Connection Local Templates Remote Templates Merged Templates

First connection [none defined] A, B A, B

Second connection A, [B renamed to
BB], C, D

[A deleted], B, C′ A, B, BB, C′, D

Example 6: Reconnecting to a remote system; duplicate templates
replaced

No templates are defined on the client workspace. One template named A and two
templates named B are defined on the remote system.
1. When a user connects to the remote system templates A, B, and B′ are

downloaded to the client workspace.
2. The user creates two additional templates named B and a template named C.

On the remote system, template B′ is deleted, and templates B′′′′ and D are
created.

3. The user disconnects from the remote system.
4. When the user connects to the remote system again:
v Templates A, B, and B′′′′ replace templates A, B, B′, B′′, and B′′′ on the client

workspace
v Template C remains on the client workspace
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v Template D is added to the client workspace

Table 10. Two connections; duplicate templates replaced

Connection Local Templates Remote Templates Merged Templates

First connection [none defined] A, B, B′ A, B, B′

Second connection A, B, B′, B′′, B′′′, C A, B, [B′ deleted],
B′′′′, D

A, B, B′′′′, C, D

Remember: In the user interface, the user sees multiple templates named B. The
prime symbols are included in these examples only to differentiate the templates
that originate on the remote system from the templates that originate on the client
workspace.

Example 7: Reconnecting to a remote system; deleted templates

No templates are defined on the client workspace. Templates A and B are defined
on the remote system.
1. When a user connects to the remote system, templates A and B are downloaded

to the client workspace.
2. The user deletes template A. On the remote system, template B is deleted.
3. The user disconnects from the remote system.
4. When the user connects to the remote system again:
v Template A is downloaded to the client workspace
v Template B remains on the client workspace

Table 11. Two connections; deleted templates

Connection Local Templates Remote Templates Merged Templates

First connection [none defined] A, B A, B

Second connection [A deleted], B A, [B deleted] A, B

Creating code templates
Create a code template for blocks of code that you use frequently.

Procedure
1. On the Templates page, click New to create a template. The New Template

window opens.
2. Complete the following fields on the window:

Name Type a name for the template. This field is required.

Context
Select a coding context for the template. This field is required. This
field determines where in a source file the template is valid.

Automatically insert
Select this check box to automatically insert the template into a new
source file.

Description
Type a description for the template.

Pattern
Type the content of the template. Justify the content of the template
pattern on the left margin. If the pattern contains multiple lines of text,
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all of the inserted lines are aligned at the column of insertion when the
template is inserted into an editor. Click Insert Variable to choose from
a list of variables to include in the template.

3. Click OK to save your template.

Editing code templates
Edit an existing template to change it.

Procedure
1. From the menu, click Window (on Windows) or IBM Developer for z Systems

(on macOS) > Preferences. Select the JCL editor and click Templates.
2. On the Templates page, select an existing template and click Edit.
3. Complete the changes and click OK.

Note: If you edit one of the default templates that are included with the
product, you can restore its original content by clicking Revert to Default.

Removing code templates
You can remove code templates from the list of available templates.

Procedure

On the Templates page, select a template in the table and click Remove.

Note: If you remove one of the default templates that are included with the
product, you can restore it by clicking Restore Removed.

Importing code templates
You can import a code template from another workspace for sharing with other
users or for moving code templates from one workspace to another.

Procedure
1. On the Templates page, click Import. The Import Templates window opens.

The default name of the export file is templates.xml.
2. Navigate to the location where the file is stored, select the file, and click Open.

The templates are loaded into the table.

Important: If any changes are made to the default templates in the export file,
then the original templates are overwritten. To restore a template to its default
state, select the template name and click Revert to Default.

Exporting code templates
You can export a code template to an XML file for sharing with other users or for
moving code templates from one workspace to another.

Procedure
1. On the Templates page, select one or more code templates and click Export.

The Export Templates window opens. The default name of the export file is
templates.xml. You can specify a different name.

2. Navigate to the location where you want to store the file and click Save. The
templates are saved to the XML file.

Important: Do not edit the export file manually. Editing a template export file
can have unpredictable results.
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Appendix. Accessibility features for z/OS Explorer

Accessibility features assist users who have a disability, such as restricted mobility
or limited vision, to use information technology content successfully.

Overview

z/OS Explorer includes the following major accessibility features:
v Keyboard-only operation
v Operations that use a screen reader
v Color and typeface preferences

z/OS Explorer uses IBM Installation Manager to install the product. You can read
about the accessibility features for IBM Installation Manager in IBM Installation
Manager documentation.

z/OS Explorer uses the latest W3C Standard, WAI-ARIA 1.0, to ensure compliance
with US Section 508 and Web Content Accessibility Guidelines (WCAG) 2.0. To
take advantage of accessibility features, use the latest release of your screen reader
and the latest web browser that is supported by z/OS Explorer.

The z/OS Explorer online product documentation in IBM Knowledge Center is
enabled for accessibility. The accessibility features of IBM Knowledge Center are
described in the Accessibility section of the IBM Knowledge Center help.

Keyboard navigation

You can use keyboard shortcuts to navigate the help system and the product
without using a mouse. For more information, see the Keyboard shortcuts for the help
system in the product topic in z/OS Explorer documentation.

Interface information

The z/OS Explorer online product documentation is available in IBM Knowledge
Center, which is viewable from a standard web browser.

PDF files have limited accessibility support. With PDF documentation, you can use
optional font enlargement, high-contrast display settings, and can navigate by
keyboard alone.

To enable your screen reader to accurately read syntax diagrams, source code
examples, and text that contains period or comma PICTURE symbols, you must set
the screen reader to speak all punctuation.

Related accessibility information

In addition to standard IBM help desk and support websites, IBM has a TTY
telephone service for use by deaf or hard of hearing customers to access sales and
support services:

TTY service 800-IBM-3383 (800-426-3383) (within North America)
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For more information about the commitment that IBM has to accessibility, see IBM
Accessibility.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing IBM Corporation North Castle Drive Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing Legal and Intellectual Property Law IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
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programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Intellectual Property Dept. for Rational Software IBM Corporation Silicon Valley Lab 555
Bailey Avnue San Jose, CA 95141-1003 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Copyright license

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2017.
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If you are viewing this information in softcopy, the photographs and color
illustrations may not appear.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect
personally identifiable information.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Terms and conditions for product documentation

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

Notices for IBM Explorer for z/OS 113

http://www.ibm.com/legal/copytrade.shtml


You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED “AS-IS” AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

Copyright license
This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Trademark acknowledgments
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at www.ibm.com/legal/
copytrade.shtml.

Adobe and PostScript are trademarks of Adobe Systems Incorporated.

Cell Broadband Engine - Sony Computer Entertainment Inc.

Rational is a trademark of International Business Machines Corporation and
Rational Software Corporation, in the United States, other countries, or both.

Intel, Intel Centrino, Intel SpeedStep, Intel Xeon, Celeron, Itanium, and Pentium
are trademarks of Intel Corporation in the United States, or other countries, or
both.

IT Infrastructure Library is a trademark of Central Computer and
Telecommunications Agency

ITIL is a trademark of The Minister for the Cabinet Office

Linear Tape-Open, LTO, and Ultrium are trademarks of HP, IBM Corp., and
Quantum

Linux is a trademark of Linus Torvalds

Microsoft, Windows, and the Windows logo are trademarks or registered
trademarks of Microsoft Corporation in the United States, or other countries, or
both.
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Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.
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